1 Support and Resources
   Online Videos .......................................................... 2
   Teacher and Technical Support ..................................... 3

3 Tour the Interface
   Tour the Menu and Toolbar .......................................... 5
   Tour the Page Tools ..................................................... 8
   Tour the Tools Palette .................................................. 9
   Tour the Controls Palette ............................................. 11
   Tour the Displays Palette ............................................ 13
   Tour the Display Area .................................................. 17
   Tour Context Help ..................................................... 18
   Tour the Scope .......................................................... 19

4 Getting Started .......................................................... 21
   DataStudio Users ....................................................... 21
   Connecting an interface .............................................. 21
      Connecting a 550 Universal Interface .......................... 26
      Connecting an 850 Universal Interface or 750 USB Interface .. 27
      Connecting Bluetooth Interfaces: such as the SPARKlink Air or AirLink2 ........ 28
      Connecting a 750 SCSI or 500 serial Interface ................ 30
      Connecting USB PASPORT Interfaces: such as the SPARK SLS, or SPARKlink ...................... 31
      Connecting an Xplorer GLX or Xplorer .......................... 32
   Connecting a sensor ................................................... 33
      Connecting a sensor with the 850 Universal Interface .......... 42
      Connecting a sensor with the 750 Interface .................... 47
      Connecting a sensor with the SPARK SLS, SPARKlink, SPARKlink Air ........ 51
| Connecting a sensor with the Xplorer GLX | 55 |
| Connecting a sensor with the Digital Adapter or Photogate Port | 60 |
| Connecting a sensor with the Analog Adapter | 61 |
| Connecting a sensor with the AirLink2 | 61 |
| Adding a display | 61 |
| Starting an experiment | 65 |
| Downloading Capstone experiments | 66 |

5 How do I... | 68 |
| How do I... Installation and Update | 71 |
| How do I automate a network installation? | 71 |
| How do I force an update to an interface? | 71 |
| How do I... Experiment Files | 72 |
| How do I download and open PASCO ready-made experiments? | 72 |
| How do I save my experiment? | 73 |
| How do I export all data? | 73 |
| How do I open DataStudio experiments and data? | 73 |
| How do I open Xplorer GLX, SPARK SLS, and other non-Capstone experiments and data? | 74 |
| How do I import data from Microsoft Excel®? | 74 |
| How do I export data to Microsoft Excel®? | 75 |
| How do I import Xplorer GLX data? | 76 |
| How do I... Data and Measurements | 78 |
| How do I record data in PASCO Capstone? | 78 |
| How do I delete data runs? | 83 |
| How do I choose one or more runs to display? | 84 |
| How do I identify a measurement when I have multiple of the same type? | 85 |
| How do I change the numerical format of data? | 86 |
How do I change the numerical format of statistics? .................................................. 88
How do I exclude, delete, and restore selected data? .............................................. 89
How do I edit a measurement? ................................................................. 92
How do I create a pure mathematical function? ..................................................... 92
How do I... Workbooks .................................................................................. 94
How do I show, hide, and lock the palettes? ......................................................... 94
How do I change which display types are available in the display toolbar? ....... 95
How do I show, hide, and lock the icons on the palettes? .................................... 97
How do I... Sensors ......................................................................................... 98
How do I zero a measurement? ....................................................................... 98
How do I switch the sign on a sensor? ............................................................. 99
How do I calibrate a sensor? ................................................................. 100
How do I calibrate a motion sensor? ............................................................. 101
How do I calibrate a drop counter? ............................................................. 102
How do I calibrate a pH sensor? ............................................................. 103
How do I... Calculations ............................................................................. 106
How do I create a calculation? ................................................................. 106
How do I use my calculation? ................................................................. 109
How do I select a measurement in the calculator? ........................................... 110
How do I see the result of a calculation? ...................................................... 110
How do I reorder calculations? ................................................................. 112
How do I... Plots ......................................................................................... 113
How do I plot multiple measurements on separate plot areas with shared X-axis? ......................................................................................... 114
How do I zoom to a selection? ................................................................. 115
How do I pan and scale? ................................................................. 117
How do I select active data? ................................................................. 118
| How do I plot multiple measurements on same plot with multiple Y-axes? | 120 |
| How do I plot multiple measurements on same plot with same Y-axes? | 122 |
| How do I apply a curve fit to a portion of the data? | 124 |
| How do I change curve fit parameters? | 125 |
| How do I adjust the weights for the weighted linear fit? | 126 |
| How do I lock and unlock the axes of a graph? | 128 |
| How do I change layer order of a display? | 130 |
| How do I... Tables | 131 |
| How do I reorder columns in a table? | 131 |
| How do I use a table to build data in Keep Mode? | 131 |
| How do I... Text Boxes | 134 |
| How do I enter subscripts, superscripts, Greek letters, and symbols? | 134 |
| How do I enter an equation into a text display? | 134 |
| How do I... Scope | 137 |
| How do I compare scope traces from the same sensor when monitoring? | 137 |
| How do I select the scope trigger? | 138 |
| How do I pre-trigger? | 141 |
| How do I freeze and record the Scope display? | 142 |
| How do I... Video | 144 |
| How do I add a video source? | 144 |
| How do I analyze a video? | 145 |
| How do I manually synchronize video with data? | 147 |
| How do I adjust the frame rate of a recorded video? | 148 |
| How do I adjust the resolution of a video? | 148 |
| How do I make files with videos smaller? | 149 |
| How do I troubleshoot video problems? | 149 |

6 FAQ 152
FAQ... PASCO Capstone  .................................................................   154
What is PASCO Capstone? ...............................................................   154
Where can I find help documentation and curriculum for PASCO Capstone? 154
What are the new features in the latest PASCO Capstone? .....................   155
Can PASCO Capstone open DataStudio, SPARKitabs, and Xplorer GLX files? ......................................................................................   155
Can Capstone files be opened on computers with different operating systems? ...............................................................................   156
FAQ... Installation and Updates ..........................................................   157
What licenses are required? .....................................................................   157
Is an MSI available for PASCO Capstone? .............................................   157
Do I need to update the interfaces? ........................................................   158
Do I need to update the sensor datasheets? ..............................................   158
FAQ... Setup ......................................................................................   159
What do I need to have a complete measurement system? ...................   159
Can sensors sample at different rates? ..................................................   161
FAQ... Data files ................................................................................   162
Where is my data saved? ........................................................................   162
What is the file export format? ...............................................................   162
What is the format for text import? ........................................................   163
FAQ... Data and Measurements ...............................................................   164
Which data is recorded? .........................................................................   164
Can sensors sample at different rates? ..................................................   164
What is Continuous Mode? ....................................................................   165
What is Fast Monitor Mode? ....................................................................   166
Is there a way to delete data points? ......................................................   167
Which data is active? ............................................................................   169
How are the curve fit and smoothing calculations determined? ............   169
1 Support and Resources

See the following instructional videos, teacher support, ready-made experiments, and other resources:

- "Online Videos": 2
- "Teacher and Technical Support": 3
- "How do I download and open PASCO ready-made experiments?": 72
- PASCO Capstone website
- "How do I...": 68
Online Videos

See the following online video sources for specific How Do I videos and general PASCO related topics.

📍Tip: Look for specific How do I... video links throughout the help topics.

**PASCO "How Do I" short videos**
https://www.youtube.com/user/paschowdoi/playlists

**PASCO YouTube Channel**
https://www.youtube.com/user/pascoscientific

**Capstone Help Website**

🔗 See "Where can I find help documentation and curriculum for PASCO Capstone?":
154
# Teacher and Technical Support

For questions about PASCO Capstone and other PASCO scientific products that are not answered in the Capstone documentation, you can contact the PASCO Teacher and Technical Support staff by phone, email, or on the Web.

<table>
<thead>
<tr>
<th>Phone:</th>
<th>1-800-772-8700 (in the U.S.)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>+1 916 786 3800 (worldwide)</td>
</tr>
<tr>
<td>Email:</td>
<td><a href="mailto:support@pasco.com">support@pasco.com</a></td>
</tr>
<tr>
<td>Web:</td>
<td><a href="http://www.pasco.com/support/">www.pasco.com/support/</a></td>
</tr>
<tr>
<td>Tech Notes:</td>
<td><a href="http://www.pasco.com/support/technical-support/technote/">www.pasco.com/support/technical-support/technote/</a></td>
</tr>
</tbody>
</table>
3 Tour the Interface

Click to learn more…

1. Menu and Toolbar
2. Page Tools
3. Tools Palette
4. Controls Palette
5. Displays Palette
6. Display Area
7. Context Help
Tour the Menu and Toolbar

The Capstone menu includes common application functions, such as file open and save, undo, help, and application specific functions, such as display settings, and journal. Some functions are available as toolbar buttons.

Descriptions for Menu and Toolbar functions: 📍Tip¹

### File

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Data...</td>
<td>Import data into the Capstone data summary.</td>
</tr>
<tr>
<td>Export Data...</td>
<td>Export collect data to a text file.</td>
</tr>
</tbody>
</table>

Preferences

- Preference File
- General Application
- Language
- Workbook
- Displays Palette
- Tools Palette
- Controls Palette

### Edit

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Undo</td>
<td>Undo the last operation. 📍Tip²</td>
</tr>
<tr>
<td>🔄</td>
<td>Redo</td>
<td>Redo an Undo operation 📍Tip²</td>
</tr>
<tr>
<td>✂</td>
<td>Cut</td>
<td>Cut the selected display element</td>
</tr>
<tr>
<td>📲</td>
<td>Copy</td>
<td>Copy the selected display element</td>
</tr>
<tr>
<td>📞</td>
<td>Paste</td>
<td>Paste a Cut or Copied display element</td>
</tr>
</tbody>
</table>

¹Capstone includes descriptions within dialog boxes. Click on an item for a brief description.
²The operation that will be undone is listed in the menu.
³The operation that will be re-done is listed in the menu.
### 3 Workbook

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Page" /></td>
<td>Add Page</td>
<td>Add Page To Workbook</td>
</tr>
<tr>
<td><img src="image" alt="Delete Page" /></td>
<td>Delete Page</td>
<td>Delete this Page</td>
</tr>
<tr>
<td><img src="image" alt="Rename Page" /></td>
<td>Rename Page</td>
<td>Rename Current Workbook Page</td>
</tr>
<tr>
<td><img src="image" alt="Lock All Pages" /></td>
<td>Lock All Pages</td>
<td>Lock all current pages for editing. Pages can still be added and will not be locked. Click Lock All Pages after adding pages to lock new pages.</td>
</tr>
<tr>
<td><img src="image" alt="Unlock All Pages" /></td>
<td>Unlock All Pages</td>
<td>Unlock pages to allow editing. How Do I Video</td>
</tr>
<tr>
<td><img src="image" alt="Edit Master Page" /></td>
<td>Edit Master Page</td>
<td>Opens the Master Page Add text and graphics to appear in the background of other pages.</td>
</tr>
</tbody>
</table>

#### Workbook Page Properties
- Page Name
- Snap to Grid
- Show Tools Palette
- Show Displays Palette
- Show Controls Palette
- Page Shape

### 4 Display

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Display" /></td>
<td>Display</td>
<td>Shows tools that apply to the selected display.</td>
</tr>
</tbody>
</table>
### 5 Journal

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Camera icon]</td>
<td>Take Journal snapshot</td>
<td>Takes an image and places it in the journal. Select:</td>
</tr>
<tr>
<td></td>
<td>Select snapshot mode</td>
<td>Snapshot Entire Workbook Page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Snapshot Workbook Page Content</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Snapshot Workbook Page Display</td>
</tr>
<tr>
<td>![List icon]</td>
<td>Show or hide Journal</td>
<td>Lists the journal snapshots and allows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Annotation icon] Show or hide annotations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Print icon] Print Journal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Export icon] Export Journal to HTML</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![View icon] View full-size snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Delete icon] Delete selected snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Up arrow] Move selected snapshot up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Down arrow] Move selected snapshot down</td>
</tr>
</tbody>
</table>

### 6 Help

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Help icon]</td>
<td>PASCO Capstone Help</td>
<td>Opens the Capstone Help System in a separate browser. A PDF version of the User's Guide is also available from the Help System.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☑️ See &quot;Where can I find help documentation and curriculum for PASCO Capstone?&quot;: 154</td>
</tr>
<tr>
<td></td>
<td>About PASCO Capstone</td>
<td>Opens a dialog with version information and the ability enter a license key.</td>
</tr>
</tbody>
</table>

### 7 Delete Display

<table>
<thead>
<tr>
<th>Icon</th>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Trash icon]</td>
<td>Delete Selected Display</td>
<td>Deletes the active display on the workbook page. Data are not affected.</td>
</tr>
</tbody>
</table>
**Tour the Page Tools**

The Page Tools include tools to add pages, change page properties, and edit the master page.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Master Page" /></td>
<td>Add text and graphics to appear in the background of other pages.</td>
</tr>
</tbody>
</table>

🔗 See "How do I... Workbooks": 94.

1. **Edit Master Page**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Master Page" /></td>
<td>Change properties of current page and Tools Palette</td>
</tr>
</tbody>
</table>

2. **Properties**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Page" /></td>
<td>Adds a new page to the workbook</td>
</tr>
<tr>
<td><img src="image" alt="Add Page" /></td>
<td>Drag and drop page tabs to rearrange the workbook pages.</td>
</tr>
</tbody>
</table>

🔗 See "Adding a display": 61.

3. **Add Page**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Add Page" /></td>
<td>Double-click to rename the page.</td>
</tr>
<tr>
<td><img src="image" alt="Add Page" /></td>
<td>Deletes the current page from the workbook.</td>
</tr>
</tbody>
</table>
Tour the Tools Palette

The Tools Palette includes tools to add interfaces and sensors, the data sets and ability to edit data properties (unit of measure, run names etc.), calibrate sensors, define calculations, define curve fit parameters, set up signal generators, and set up timers.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hardware Setup</td>
</tr>
<tr>
<td></td>
<td>Configure interface and sensor hardware</td>
</tr>
<tr>
<td></td>
<td>See &quot;Connecting an interface&quot;: 21.</td>
</tr>
<tr>
<td>2</td>
<td>Timer Setup</td>
</tr>
<tr>
<td></td>
<td>Create timers for photogates and other timing devices</td>
</tr>
<tr>
<td>3</td>
<td>Data Summary</td>
</tr>
<tr>
<td></td>
<td>Manage experiment data and data properties</td>
</tr>
<tr>
<td></td>
<td>See &quot;How do I... Data and Measurements&quot;: 78.</td>
</tr>
<tr>
<td>4</td>
<td>Calibration</td>
</tr>
<tr>
<td></td>
<td>Calibrate sensor measurements</td>
</tr>
<tr>
<td></td>
<td>See &quot;How do I... Sensors&quot;: 98.</td>
</tr>
<tr>
<td>5</td>
<td>Calculator</td>
</tr>
<tr>
<td></td>
<td>Define new data sets as functions of measurements and other data</td>
</tr>
<tr>
<td></td>
<td>See &quot;How do I... Calculations&quot;: 106.</td>
</tr>
<tr>
<td>6</td>
<td>Signal Generator</td>
</tr>
<tr>
<td></td>
<td>Control interface Signal Generator output</td>
</tr>
</tbody>
</table>
### Digital Output

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Specify behavior for expansion port inputs and/or outputs</td>
</tr>
</tbody>
</table>

### Curve Fit Editor

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Edit curve fits created in Graph displays</td>
</tr>
</tbody>
</table>

🔗 See "How do I change curve fit parameters?": 125.
Tour the Controls Palette

The Controls Palette is used to start/stop data collection, set the data monitoring mode, set the sampling rate, delete data runs, define Start/Stop conditions, and playback synchronized video.

1 Record / Play Selection

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Toggle between:</td>
</tr>
<tr>
<td>🎥</td>
<td>Recording Mode</td>
</tr>
<tr>
<td>🔁</td>
<td>Playback Mode</td>
</tr>
</tbody>
</table>

2 Record / Monitor

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Capstone toggles between:</td>
</tr>
<tr>
<td>🎥</td>
<td>Record</td>
</tr>
<tr>
<td>🔁</td>
<td>Monitor</td>
</tr>
</tbody>
</table>

3 Record Mode Selection

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Toggle between:</td>
</tr>
<tr>
<td>🎥 🔁</td>
<td>Continuous Mode</td>
</tr>
<tr>
<td>🔁</td>
<td>Keep Mode</td>
</tr>
<tr>
<td>🎥 🎥</td>
<td>Fast Monitor Mode</td>
</tr>
</tbody>
</table>

📝 See "How do I record data in PASCO Capstone? " : 78
### Record Timer

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays the recording time as reported by the sensors in <strong>minutes:seconds</strong> format.</td>
</tr>
<tr>
<td>Displays the recording status: <strong>Ready</strong> or <strong>Recording</strong></td>
</tr>
</tbody>
</table>

### Sampling Source and Sample Rate

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sampling rate source: single sensor or <strong>Common Rate</strong></td>
</tr>
</tbody>
</table>

**Note:** Common Rate is applied to all sensors. The Sample Rate range for Common Rate is intersection of all sensor ranges.

<table>
<thead>
<tr>
<th>Adjust the <strong>Sample Rate</strong></th>
</tr>
</thead>
</table>

### Start / Stop Conditions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Set automatic Start/Stop conditions</td>
</tr>
</tbody>
</table>

**How Do I Video**

### Delete Runs

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete most recent run</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Delete All Runs or a specific run</td>
</tr>
</tbody>
</table>
Tour the Displays Palette

The Displays Palette is used to add displays to workbook pages. Displays can be added by double clicking or drag and drop using QuickStart templates or drop targets. (See "Adding a display": 61.)

<table>
<thead>
<tr>
<th>Drag to page or double-click to create a display:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
</tr>
<tr>
<td><strong>Graph</strong></td>
</tr>
<tr>
<td><strong>Icon</strong></td>
</tr>
<tr>
<td><img src="image1" alt="Graph Icon" /></td>
</tr>
<tr>
<td><img src="image2" alt="See &quot;How do I... Plots&quot;: 113." /></td>
</tr>
<tr>
<td><strong>2</strong></td>
</tr>
<tr>
<td><strong>Scope</strong></td>
</tr>
<tr>
<td><strong>Icon</strong></td>
</tr>
<tr>
<td><img src="image3" alt="Scope Icon" /></td>
</tr>
<tr>
<td><img src="image4" alt="See &quot;Tour the Scope&quot;: 19" /></td>
</tr>
<tr>
<td><strong>3</strong></td>
</tr>
<tr>
<td><strong>FFT</strong></td>
</tr>
<tr>
<td><strong>Icon</strong></td>
</tr>
<tr>
<td><img src="image5" alt="FFT Icon" /></td>
</tr>
</tbody>
</table>
4 **Histogram**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Histogram Icon" /></td>
<td>Create a histogram bar graph. The height of each of the bars is proportional to the number of data that fall within the range of values that the bar represents. Several tools are available for histograms including statistics, setting bin sizes, and overlaying.</td>
</tr>
</tbody>
</table>

5 **Digits**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Digits Icon" /></td>
<td>Create a digits display to show the current data value or a statistical value.</td>
</tr>
</tbody>
</table>

6 **Meter**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Meter Icon" /></td>
<td>Create a meter display to indicate the current data value (or statistical value) by the angular displacement of a needle against a dial indicator. Several meter styles are available.</td>
</tr>
</tbody>
</table>
7 Table

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create a table to list captured data or user defined data in columns.</td>
</tr>
</tbody>
</table>

**Note:** Tables are used to enter user-defined numerical or text data. Several tools are available for tables including statistics.

🔗 See "How do I... Tables": 131.

8 Text Box

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create a text box for explanatory text and images. The text box can be locked for editing. 📚Tip1</td>
</tr>
</tbody>
</table>

🔗 See "How do I... Text Boxes": 134.

9 Text Entry Box

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create a text entry box for user input. The input can be linked to other text entry boxes. 📜Tip1</td>
</tr>
</tbody>
</table>

🔗 See "How do I... Text Boxes": 134.

---

1 Use a Text Entry Box for user student input on a locked experiment.
1 Use the linkage to present a previously entered student response on a subsequent page of the Workbook. For example, to combine all the answers on a single page.
### 10 Image

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image_icon.png" alt="Image Icon" /></td>
<td>Create a box to insert an image from a file. <strong>Note:</strong> Use the Movie icon to capture an image from an attached USB camera.</td>
</tr>
</tbody>
</table>

### 11 Movie

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="movie_icon.png" alt="Movie Icon" /></td>
<td>Create a box to insert a movie file, capture an image from a video camera or microscope connected through a USB port, record a stand-alone video using a USB webcam, or use a USB video camera as a sensor to record a movie along with other sensor data. &lt;br&gt; &lt;br&gt; A special video analysis mode accessed from the toolbar provides tools for analyzing videos and image snapshots.</td>
</tr>
</tbody>
</table>

atories |
| ![Movie Icon](movie_icon.png) | See "How do I... Video": 144. |

### 12 Placeholder

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="placeholder_icon.png" alt="Placeholder Icon" /></td>
<td>Create a spacer for a display to be defined at a later time or create white space.</td>
</tr>
</tbody>
</table>
Tour the Display Area

The PASCO Capstone Workbook pages facilitate quick and easy layouts and support highly flexible page designs.

<table>
<thead>
<tr>
<th>Features</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop targets</td>
<td>&quot;Adding a display&quot;: 61</td>
</tr>
<tr>
<td>Easy resize and alignment tools</td>
<td>&quot;Adding a display&quot;: 61</td>
</tr>
<tr>
<td>QuickStart templates</td>
<td>&quot;Adding a display&quot;: 61</td>
</tr>
</tbody>
</table>

Features

- QuickStart Templates

Easy table creation, including calculated data

- "How do I... Tables": 131
- "How do I... Calculations": 106

Text boxes with equations copied from word processor

- "How do I... Text Boxes": 134
Tour Context Help

Some items in PASCO Capstone include helpful information at the bottom of dialog windows. Click on an item for a brief description.

1. Click on an item for a brief description.
2. Information displays here.
Tour the Scope

Overview

The scope is designed to view high-frequency oscillating data or single high-speed events that the graph display may not be able to capture.

**Maximum Sampling Rate:** The maximum supported sampling rate is a function of the computer-sensor interface that is connected to the computer (for example: 850 Universal Interface $\rightarrow$ 10 MHz, ScienceWorkshop 750 $\rightarrow$ 250 kHz).

### Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Mode</td>
<td>&quot;What is Continuous Mode?&quot;: 165</td>
</tr>
<tr>
<td>Fast Monitor Mode</td>
<td>&quot;What is Fast Monitor Mode?&quot;: 166</td>
</tr>
<tr>
<td>Single shot</td>
<td>&quot;What does Single Shot do?&quot;: 175</td>
</tr>
<tr>
<td>Multiple triggers</td>
<td>&quot;How do I select the scope trigger?&quot;: 138</td>
</tr>
<tr>
<td>Pre-trigger</td>
<td>&quot;How do I pre-trigger?&quot;: 141</td>
</tr>
<tr>
<td>Image freeze</td>
<td>&quot;How do I freeze and record the Scope display?&quot;: 142</td>
</tr>
</tbody>
</table>

### Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Adjust y-axis scale to fit data</td>
</tr>
<tr>
<td></td>
<td>Activate and control scope trigger</td>
</tr>
<tr>
<td></td>
<td>Stop collection after one trace</td>
</tr>
<tr>
<td></td>
<td>Automatically adjust sample rate based on time-axis scale</td>
</tr>
<tr>
<td></td>
<td>Activate to view multiple runs; Select visible run(s)</td>
</tr>
<tr>
<td></td>
<td>Increase trace offset</td>
</tr>
<tr>
<td></td>
<td>Set trace offset value to zero</td>
</tr>
<tr>
<td></td>
<td>Decrease trace offset</td>
</tr>
<tr>
<td></td>
<td>Show data coordinates and access Delta Tool</td>
</tr>
<tr>
<td></td>
<td>Creates a data set from active traces</td>
</tr>
<tr>
<td></td>
<td>Increase number of data points in trace</td>
</tr>
<tr>
<td></td>
<td>Decrease number of data points in trace</td>
</tr>
<tr>
<td></td>
<td>Add new y-axis to scope display</td>
</tr>
<tr>
<td></td>
<td>Remove active element or axis</td>
</tr>
<tr>
<td></td>
<td>Allow rearrangement of axes</td>
</tr>
</tbody>
</table>
Pin toolbar to display

Properties

Show or hide tools

See "Adding a display": 61
Getting Started

See the following topics setting up and run a simple experiment:

"Connecting an interface": 21
"Connecting a sensor": 33
"Adding a display": 61
"Starting an experiment": 65
"Downloading Capstone experiments": 66

See "How do I...": 68 for detailed instructions.

DataStudio Users

"How do I open DataStudio experiments and data?": 73
"Can PASCO Capstone open DataStudio, SPARKlabs, and Xplorer GLX files?": 155
"What is PASCO Capstone?": 154
"Where can I find help documentation and curriculum for PASCO Capstone?": 154
"What are the new features in the latest PASCO Capstone?": 155
"How do I...": 68
"FAQ": 152

Connecting an interface

Capstone software running on your computer receives data from one or more connected sensors through one or more interfaces. (At least one interface and sensor is required to collect data. (See "What do I need to have a complete measurement system?": 159)

Capstone is compatible with all PASCO USB interfaces and some non-USB interfaces using a serial-to-USB convertor. 👤Tip1

Add a Bluetooth interface

1. Connect one or more PASCO Bluetooth interfaces to the computer. 👤Tip2

---

1 You can add interfaces that are not connected to the computer. This is useful to author or prepare experiments in advance.
2 Interfaces can be connected to your computer with Capstone running. Capstone will automatically add recognized interfaces such as the 850 Universal Interface.
Connecting a Polarimeter

"Connecting a 550 Universal Interface": 26

"Connecting Bluetooth Interfaces: such as the SPARKlink Air or AirLink2": 28

2. Add one or sensors. (See "Connecting a sensor": 33)

Automatically detect an interface

1. Connect one or more PASCO USB interfaces to the computer. 🌍Tip

   "Connecting a 550 Universal Interface": 26

   "Connecting an 850 Universal Interface or 750 USB Interface": 27

   "Connecting a 750 SCSI or 500 serial Interface": 30

   "Connecting Bluetooth Interfaces: such as the SPARKlink Air or AirLink2": 28

   "Connecting USB PASPORT Interfaces: such as the SPARK SLS, or SPARKlink": 31

   "Connecting an Xplorer GLX or Xplorer": 32

2. Add one or sensors. (See "Connecting a sensor": 33)

Manually add an interface

2. Add the interface if not displayed in the Hardware Setup list. 🌈Tip

3. If the interface is not automatically detected: ⚛️ click Choose Interface.
4. The Choose Interface dialog opens.

---

*Some PASCO interfaces, such as the PASCO 850 and SPARK, are automatically detected by Capstone when plugged in and turned on.*
Choose Interface

1. Click **Manually Choose**.

2. Click the interfaces to add or remove.

3. Optional: change the default of 1 interface to add multiple interfaces of the same type.
5. Add one or sensors. (See "Connecting a sensor": 33)

Connected and added interfaces are displayed in the Hardware Setup dialog.

**Note:** Interfaces that are connected to the computer, powered on, and recognized by Capstone display (▲) and interfaces that are not active display (⚠️).
Active and inactive interfaces and sensors in Hardware Setup

Next step: "Connecting a sensor": 33

Connecting a 550 Universal Interface

The 550 Universal Interface includes two digital inputs, two analog ports, two PASPORT sensor ports, and a 3.2 W function generator.

Procedure

1. Connect the AC adapter to a wall outlet and to the AC adapter port on the rear of the 550 Universal Interface.

2. Optional: Use the A-to-mini-B USB cable to connect the smaller USB port of the 550 Universal Interface to a USB port on your computer (or a USB hub connected to the computer).
3. Press and hold the power button ( питания ) until the green lights on the front flash.

4. Configure the interface for Capstone. (

5. Click Bluetooth

6. Select the interface from the drop down list.
   The interface displays in the Hardware Setup.

7. Select the interface by Bluetooth ID in the drop down list.

8. Add sensors. (See "Connecting a sensor with the 850 Universal Interface": 42)

Next step: "Connecting a sensor": 33

Connecting an 850 Universal Interface or 750 USB Interface

The PASCO 850 Universal Interface includes four digital inputs, four analog ports, four PASPORT sensor ports, a 15 W function generator, dual high speed function generators.

Procedure

1. Use the A-to-mini-B USB cable to connect the smaller USB port of the 850 Universal Interface to a USB port on your computer (or a USB hub connected to the computer).
2. Connect the AC adapter to a wall outlet and to the AC adapter port on the rear of the 850 Universal Interface.

3. Press and hold the power button ( ■ ) until the green lights on the front flash.

4. Configure the interface for Capstone. (See "Connecting an interface": 21)

5. Add sensors. (See "Connecting a sensor with the 850 Universal Interface": 42)

Next step: "Connecting a sensor": 33

Connecting Bluetooth Interfaces: such as the SPARKlink Air or AirLink2

SPARKlink Air is a sensor interface with two ports to accept PASPORT sensors and ports for the included Voltage Probe and Temperature Probe.

The SPARKlink Air interface connects to a computer or tablet device wirelessly via Bluetooth (radio), or can also connect to a computer’s USB port with the included USB cable. The SPARKlink Air operates on battery power or can be connected to the included AC adapter. The SPARKlink Air battery can also be recharged using the USB cable connected to a USB port.

Procedure
1. Optional: Connect the AC adapter (included with the SPARKlink Air) to a wall outlet and to the AC adapter port on the bottom of the device.

The Battery Status LED may blink red to indicate that the battery is charging through the power cable.

2. Connect the SPARKlink Air to the computer via Bluetooth or USB.

**Pairing Bluetooth**

i. Press and hold the ON/OFF button on the SPARKlink Air.

   ➤ The Bluetooth status LED will blink blue.

ii. After the status LEDs blink in sequence, release the ON/OFF button.

iii. Enable the Windows or Macintosh computer for Bluetooth communication.

**USB Connection**

i. Use an A-to-mini-B USB cable (such as PASCO part PS-2528) to connect the smaller USB port of the SPARK to a USB port on your computer (or a USB hub connected to the computer).

ii. Press and hold the ON/OFF button on the SPARKlink Air.

iii. After the status LEDs blink in sequence, release the ON/OFF button.

   ➤ The USB Status LED will shine green. The Battery Status LED may blink red to indicate that the battery is charging through the USB.
3. Plug in PASPORT sensors, temperature probe, or voltage leads.

4. Configure the interface for Capstone. (See "Connecting an interface": 21)

Next step: "Connecting a sensor": 33

Connecting a 750 SCSI or 500 serial Interface

1. Use the A-to-mini-B USB cable (included with the 750 Interface) to connect the USB port of the 750 Interface to a USB port on your computer (or a USB hub connected to the computer).
2. Connect the AC adapter to a wall outlet and to the AC adapter port on the rear of the 750 Interface.
3. Turn on the interface and hold the power button.
4. Configure the interface for Capstone. (See "Connecting an interface": 21)
5. Add sensors. (See "Connecting a sensor with the 750 Interface": 47)

Next step: "Connecting a sensor": 33

Connecting USB PASPORT Interfaces: such as the SPARK SLS, or SPARKlink

1. Use an A-to-mini-B USB cable (such as PASCO part PS-2528) to connect the smaller USB port of the SPARK SLS or SPARKlink to a USB port on your computer (or a USB hub connected to the computer).
2. Optionally connect the AC adapter (included with the SPARK SLS and SPARKlink) to a wall outlet and to the AC adapter port on the bottom of the device.
3. Plug in PASPORT sensors, temperature probe, or voltage leads.
4. SPARK SLS: Press and hold the power button until the SPARK SLS screen turns on.

5. Configure the interface for Capstone. (See "Connecting an interface": 21)

6. SPARK SLS: The SPARK SLS states it is connected to a computer. Disconnect the SPARK SLS from the computer to use it in standalone mode.

Next step: "Connecting a sensor": 33

Connecting an Xplorer GLX or Xplorer

1. Use an A-to-mini B USB cable (included) to connect the smaller USB port of the Xplorer GLX to a USB port on your computer (or a USB hub connected to the computer).

2. Optionally, connect the included AC adapter to a wall outlet and to the AC adapter port on the right side of the Xplorer GLX.

3. If the Xplorer GLX is not on, press and hold the power button until the green LED on the front flashes.

4. Configure the interface for Capstone. (See "Connecting an interface": 21)
Connecting a sensor

Capstone software running on your computer receives data from one or more connected sensors through one or more interfaces. (At least one interface and sensor is required to collect data. (See "What do I need to have a complete measurement system?": 159)

Follow these steps to connect a sensor to your computer.

1. If not already, connect or add an interface to your computer. (See "Connecting an interface": 21)

   **Note:** Capstone requires an interface to communicate with the sensor.

2. Plug in one or more sensors into the interface.

   📺 **Click for instructions on select interfaces**
   
   "Connecting a sensor with the 850 Universal Interface": 42
   
   "Connecting a sensor with the 750 Interface": 47
   
   "Connecting a sensor with the SPARK SLS, SPARKlink, SPARKlink Air": 51
   
   "Connecting a sensor with the Xplorer GLX": 55
   
   "Connecting a sensor with the Digital Adapter or Photogate Port": 60
   
   "Connecting a sensor with the Analog Adapter": 61
   
   "Connecting a sensor with the AirLink2": 61

3. Add the sensor in Capstone 🏷️ **Tip**

   PASPORT sensor

   **Note:** Capstone automatically detects properly connected PASPORT sensors.

---

Tip 1: You can add sensors that are not connected to the interface. This is useful to author or prepare experiments in advance.
Automatically detected PASPORT sensors

To manually add a PASPORT sensor:
a. Click within the yellow circle of the port to add a sensor.

![Interface: PASPORT port indicators](image)

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

![Sensor icon](image)

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

---

Analog ScienceWorkshop sensor (Universal Interface)

**Note:** Capstone automatically detects Universal Interface (UI) sensors.

To add a *non-connected* sensor to Capstone:
a. Click within the yellow circle of the port to add a sensor.

**Interface: Analog Port Indicators**

b. Select the sensor to add from the drop down list. The sensor icon appears for the port.

**Sensor icon**

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

**Digital sensor (ScienceWorkshop)**

*Note:* Capstone does not automatically detect most digital sensors.
a. Click within the yellow circle of the port to add a sensor.

![Interface: Digital Port Indicators]

b. Select the sensor to add from the drop down list. The sensor icon appears for the port.

![Sensor icon]

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

c. Optional: to use the sensor as a timer, click Timer Setup in the Tools Palette.
Timer Setup

Create timers for photogates and other timing devices.

Analog sensor (ScienceWorkshop)

Note: Capstone does not automatically detect most analog ScienceWorkshop sensors.

a. Click within the yellow circle of the port to add a sensor.

Interface: Analog Port Indicators

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.
Analog sensors do not toggle between inactive and active and display as active (green line) even when disconnected.

Temperature sensor (SPARK SLS, SPARKlink, SPARKlink Air, and Xplorer GLX)

**Note:** Capstone automatically detects temperature sensors connected to the internal temperature sensor port.

To manually add a temperature sensor:

a. Click within the yellow circle of the temperature port to add a temperature sensor.

*Interface: Temperature port indicators*

The sensor icon appears for the port.
Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Voltage sensor (SPARK SLS, SPARKlink, SPARKlink Air, and Xplorer GLX)

Note: Capstone automatically detects sound sensors connected to the internal sound sensor port.

To manually add a voltage sensor:

a. Click within the yellow circle of the port to add a voltage sensor.

Interface: Voltage port indicators

The sensor icon appears for the port.
Sensor icon

Active Sensor

Inactive Sensor

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Sound sensor (Xplorer GLX)

**Note:** Capstone automatically detects voltage sensors connected to the internal voltage sensor port.

To manually add a sound sensor:

a. Click within the yellow circle of the port to add a sound sensor.

b. Select the GLX Sound Level Sensor or the GLX Sound Sensor.

The sensor icon appears for the port.
Connecting a sensor with the 850 Universal Interface

1. Plug in PASPORT sensors, digital ScienceWorkshop sensors, or analog ScienceWorkshop (black) sensors.

2. Add the sensor in Capstone:

   **PASPORT sensor**

   **Note:** Capstone automatically detects properly connected PASPORT sensors.

   PASPORT sensors are automatically detected.
To manually add a PASPORT sensor:
a. Click within the yellow circle of the port to add a sensor.

Interface: PASPORT port indicators

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Digital sensor (ScienceWorkshop)

Note: Capstone does not automatically detect most digital sensors.

a. Click within the yellow circle of the port to add a sensor.

Interface: Digital Port Indicators

b. Select the sensor to add from the drop down list.
The sensor icon appears for the port.

Sensor icon

Active Sensor

Inactive Sensor

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

c. Optional: to use the sensor as a timer, click Timer Setup in the Tools Palette.

Timer Setup

Create timers for photogates and other timing devices/Inactive Sensor

Analog sensor (ScienceWorkshop)

Note: Capstone does not automatically detect most analog ScienceWorkshop sensors.
a. Click within the yellow circle of the port to add a sensor.

![Interface: Analog Port Indicators](image)

b. Select the sensor to add from the drop down list.

- The sensor icon appears for the port.

![Sensor icon](image)

Analogue sensors do not toggle between inactive and active and display as active (green line) even when disconnected.

**Analog ScienceWorkshop sensor (Universal Interface)**

**Note:** Capstone automatically detects Universal Interface (UI) sensors.

To add a *non-connected* sensor to Capstone:
a. Click within the yellow circle of the port to add a sensor.

Interface: Analog Port Indicators

b. Select the sensor to add from the drop down list.
- The sensor icon appears for the port.

Sensor icon

Active Sensor

Inactive Sensor

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Next step: "Adding a display ": 61

Connecting a sensor with the 750 Interface

1. Plug digital ScienceWorkshop sensors or analog ScienceWorkshop (black) sensors.
2. Add the sensor in Capstone:

Digital sensor (ScienceWorkshop)

**Note:** Capstone does not automatically detect most digital sensors.

a. Click within the yellow circle of the port to add a sensor.

**Interface: Digital Port Indicators**

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.
c. Optional: to use the sensor as a timer, click Timer Setup in the Tools Palette.

Analog sensor (ScienceWorkshop)

**Note:** Capstone does not automatically detect most analog ScienceWorkshop sensors.

a. Click within the yellow circle of the port to add a sensor.

**Interface: Analog Port Indicators**

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

**Sensor icon**

Analog sensors do not toggle between inactive and active and display as active (green line) even when disconnected.

**Analog ScienceWorkshop sensor (Universal Interface)**
Note: Capstone automatically detects Universal Interface (UI) sensors.

To add a non-connected sensor to Capstone:

a. Click within the yellow circle of the port to add a sensor.

Interface: Analog Port Indicators

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

Sensor icon

Active Sensor

Inactive Sensor

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Next step: "Adding a display": 61
Connecting a sensor with the SPARK SLS, SPARKlink, SPARKlink Air

1. Plug in PASPORT sensors, temperature probe, and/or voltage leads.

2. Press and hold the power button.

3. Configure the interface for Capstone. (See "Connecting an interface": 21)

4. Add the sensor in Capstone:

**PASPORT sensor**

*Note:* Capstone automatically detects properly connected PASPORT sensors.
To manually add a PASPORT sensor:
a. Click within the yellow circle of the port to add a sensor.

Interface: PASPORT port indicators

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Temperature sensor

Note: Capstone automatically detects temperature sensors connected to the internal temperature sensor port.

To manually add a temperature sensor:

a. Click within the yellow circle of the temperature port to add a temperature sensor.

Interface: Temperature port indicators

The sensor icon appears for the port.
Sensor icon

<table>
<thead>
<tr>
<th>Active Sensor</th>
<th>Inactive Sensor</th>
</tr>
</thead>
</table>

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Voltage sensor

**Note:** Capstone automatically detects sound sensors connected to the internal sound sensor port.

To manually add a voltage sensor:

1. ✉️ Click within the yellow circle of the port to add a voltage sensor.

Interface: Voltage port indicators

-The sensor icon appears for the port.
Connecting a sensor with the Xplorer GLX

1. Plug in PASPORT sensors, temperature probe, or voltage leads.

2. 

Next step: "Adding a display": 61
3. Press and hold the power button.

4. Configure the interface for Capstone. ([See "Connecting an interface": 21])

5. Add the sensor in Capstone:

**PASPORT sensor**

*Note:* Capstone automatically detects properly connected PASPORT sensors.

**Automatically detected PASPORT sensors**

To manually add a PASPORT sensor:
a. Click within the yellow circle of the port to add a sensor.

Interface: PASPORT port indicators

b. Select the sensor to add from the drop down list.

The sensor icon appears for the port.

Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Temperature sensor

Note: Capstone automatically detects temperature sensors connected to the internal temperature sensor port.

To manually add a temperature sensor:

a. Click within the yellow circle of the temperature port to add a temperature sensor.

Interface: Temperature port indicators

The sensor icon appears for the port.
Sensor icon

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

Voltage sensor

**Note**: Capstone automatically detects sound sensors connected to the internal sound sensor port.

To manually add a voltage sensor:

1. Click within the yellow circle of the port to add a voltage sensor.

**Interface: Voltage port indicators**

- The sensor icon appears for the port.
**Sensor icon**

<table>
<thead>
<tr>
<th>Active Sensor</th>
<th>Inactive Sensor</th>
</tr>
</thead>
</table>

Active: the connect line turns green when Capstone detects the sensor on an active interface. Inactive: the sensor is indicated as unconnected by a red connect line and an inactive symbol.

**Sound sensor**

**Note:** Capstone automatically detects voltage sensors connected to the internal voltage sensor port.

To manually add a sound sensor:

a. ![Click within the yellow circle of the port to add a sound sensor](image)

b. Select the GLX Sound Level Sensor or the GLX Sound Sensor.

   ![The sensor icon appears for the port](image)
Connecting a sensor with the Digital Adapter or Photogate Port

The Digital Adapter (PASCO part PS-2159) allows any ScienceWorkshop digital sensor sensors to be connected to a PASPORT interface to be used with Capstone. It also allows the use of the ScienceWorkshop Motion Sensor (CI-6742A) and the Rotary Motion Sensor (CI-6538).

The Photogate Port (PS-2123) is an obsolete adapter that supports switch-type sensors, but not the Rotary Motion Sensor or Motion Sensor.

Procedure

1. Connect the adapter to your PASPORT interface.
2. Connect a digital sensor to the adapter.
   - You can connect a switch-type sensor to either port of the adapter.
   - If you are connecting a Motion Sensor or Rotary Motion Sensor, connect the yellow plug to Port 1 and the black plug to Port 2.
3. Click one of the digital adapter in Capstone.
   - A list of digital sensors and sensor configurations appears.
4. Optionally, connect a second switch-type sensor to the other port of the adapter.
5. In the list, click one of the sensors or configurations to select it.

Next step: "Adding a display ": 61
Connecting a sensor with the Analog Adapter

The Analog Adapter (PASCO part PS-2158) allows analog ScienceWorkshop sensors to be connected to a PASPORT interface to be used with Capstone.

Procedure

1. Connect the Analog Adapter to your PASPORT interface.
2. Connect an analog sensor to the adapter.
   → A list of sensors appears.
3. Click one of the sensors to select it.
4. Optionally, click the Gain box and click a gain setting.
5. Click OK.

Next step: "Adding a display": 61

Connecting a sensor with the AirLink2

The AirLink2 sensor interface can communicate with computers using the USB connection or via the Bluetooth interface.

Next step: "Adding a display": 61

Adding a display

Capstone provides a highly flexible environment for workbook page layout.

Pages can be created using any combination of templates, drag and drop to targets, and moving and resizing display elements.

Use a QuickStart template

1. Click one of the provided templates. Tip

Tip: You can add or remove display elements after you select a template.
2. The selected layout appears in the Display Area.

3. ![Select Measurement] Click **Select Measurement** for each display.

4. Select the measurement in the drop-down list.

**Note:** Sensors that are inactive (not ready to collect data) appear with ![Warning].

(See "Connecting an interface": 21 and "Connecting a sensor": 33)

**Use drag & drop and targets**

1. ![Click] Click one of the display icons in the Displays Palette.

   ![See] See "Tour the Displays Palette": 13 for a description of the available display types.

2. Drag the icon to the Display Area.

3. Use the Page layout targets to quickly format the page.

   **Using Page layout targets**

   1. Drag a display icon to one of the five targets.
   2. Move the cursor around open area of the page.
   3. The target turns darker as you approach it and is selected when the border on the target appears.
   4. Drop the icon on a selected target.

   ![Page] Page targets divide the available area into the following five sections: ![Tip]

   **Note:** Page targets divide either an open area or an existing display.

---

1Use targets to quickly divide an existing display into two displays.
4. The selected layout appears in the Display Area. 🛡Tip
5. Add more displays noting the Page layout targets.
6. ✍️Click <Select Measurement> for each display.
7. Select the measurement in the drop-down list.

Note: Sensors that are inactive (not ready to collect data) appear with ⚠️.
(✍See "Connecting an interface": 21 and "Connecting a sensor": 33)

Moving and resizing

Capstone uses handles to move and resize individual displays on a page. Capstone includes vertical and horizontal alignment borders for easy display alignment.

1You can add or remove display elements after you select a template.
Moving a display

1. 𫖯 Click on the display you wish to move to make it active.
2. .Move the cursor until the border darkens and the move (hand) symbol appears.

3.  фа Click and drag the display to new location.

Note: The alignment guides appear (dotted lines) when the display border aligns with adjacent displays.

Resizing a display

1. adar Click on the display to move to make it active.
2.  Move the cursor to one of the eight resize handles (circle  0  ).

3. xfa Click and drag the border to new position.

Note: The alignment guides appear (dotted lines) when the display border aligns with adjacent displays.

Realigning displays

1.  Move the cursor between displays until the desired move border symbol appears.
2. **Click** and **drag** the border to new position. This action might affect multiple displays. 

   It might be necessary to move displays to align to a common alignment border. (See "Adding a display": 61)

Next step: "Starting an experiment": 65

### Starting an experiment

Capstone provides several controls in the **Controls Palette** for collecting data.

#### Pre-work

1. Connect one or more interfaces. (See "Connecting an interface": 21)
2. Connect one or more sensors. (See "Connecting a sensor": 33)
3. Add one or displays. (See "Adding a display": 61)

**Note:** Sensors that are inactive (not ready to collect data) appear with ![warning](https://via.placeholder.com/15). Additionally, **Record** turns gray ![record](https://via.placeholder.com/15) if there is not at least one active interface and sensor. (See "Connecting an interface": 21 and "Connecting a sensor": 33)
1. Click **Record** in the **Controls Palette**.

   ![Record](image)

   - Capstone begins recording all available data.
   - **Record** toggles to **Stop**.

2. Click **Stop** in the **Controls Palette** to stop data collection.

   - Collected data appear in all displays of the current page.
   - The data run is listed in the legend for each display.
   - Recorded data appear on the **Sensor Data Summary** tab (⬇️) in **Data Summary**, and is selectable from any data display with a default name **Run #%1**, where %1 is an automatically generated run number.

   ✂️ See "How do I record data in PASCO Capstone? ": 78 for details.

### Removing data runs

- **Delete Last Run**: ![Click](image) in the **Controls Palette**.
- **Delete Selected Runs**: ![Click](image) the down arrow next to **Delete Last Run** and select a specific run.
- **Delete All Runs**: ![Click](image) the down arrow next to **Delete Last Run** and select **Delete All Runs**. 📋Tip

   **Note**: The run data is removed from all displays, legends, and the data summary. 🔄 Click **Undo** at the top to recover the data.

**Next step (optional): "Downloading Capstone experiments": 66**

### Downloading Capstone experiments

PASCO provides several ready-made experiments for Capstone. 📏Tip

---

1. You can delete all data for the run and repeat data collection.
2. The lab might contain multiple pages including: ⚫ introduction ⚫ theory ⚫ setup & procedures ⚫ analysis ⚫ conclusions
1. Go to the Capstone experiments web page: http://www.pasco.com/family/capstone-experiments/index.cfm

2. Select a subject area, for example Thermodynamics (Thermodynamics).

3. Select the Free Experiment Files (Free Experiment Files) tab.

4. Scroll through the list of ready-made experiments and click to download the experiment files.

5. Copy the files from your download folder to your Capstone experiments folder.
   - The download might contain the following:
     - Capstone application files; these have a ".cap" file extension
     - Editable lab guides
     - Images

6. Open the *.cap file from Capstone.
   a. Click File > Open Experiment....
   b. Navigate to the experiment file.
   c. Click Open.
5 How do I...

Installation and Update

"How do I automate a network installation?": 71
"How do I force an update to an interface?": 71

Experiment Files

"How do I download and open PASCO ready-made experiments?": 72
"How do I save my experiment?": 73
"How do I export all data?": 73
"How do I open DataStudio experiments and data?": 73
"How do I open Xplorer GLX, SPARK SLS, and other non-Capstone experiments and data?": 74
"How do I import data from Microsoft Excel*?": 74
"How do I export data to Microsoft Excel*?": 75
"How do I import Xplorer GLX data?": 76

Data and Measurements

"How do I record data in PASCO Capstone?": 78
"How do I delete data runs?": 83
"How do I choose one or more runs to display?": 84
"How do I identify a measurement when I have multiple of the same type?": 85
"How do I change the numerical format of data?": 86
"How do I change the numerical format of statistics?": 88
"How do I exclude, delete, and restore selected data?": 89
"How do I edit a measurement?": 92
"How do I create a pure mathematical function?": 92

Workbooks

"How do I show, hide, and lock the palettes?": 94
"How do I change which display types are available in the display toolbar?": 95

Sensors

"How do I zero a measurement?": 98
"How do I switch the sign on a sensor?": 99
"How do I calibrate a sensor?": 100
"How do I calibrate a motion sensor?": 101
"How do I calibrate a drop counter?": 102
"How do I calibrate a pH sensor?": 103

Calculations

"How do I create a calculation? ": 106
"How do I use my calculation?": 109
"How do I select a measurement in the calculator?": 110
"How do I see the result of a calculation?": 110
"How do I reorder calculations?": 112

Plots

"How do I plot multiple measurements on separate plot areas with shared X-axis?": 114
"How do I zoom to a selection?": 115
"How do I pan and scale?": 117
"How do I select active data?": 118
"How do I plot multiple measurements on same plot with multiple Y-axes?": 120
"How do I plot multiple measurements on same plot with same Y-axes?": 122
"How do I apply a curve fit to a portion of the data?": 124
"How do I change curve fit parameters?": 125
"How do I adjust the weights for the weighted linear fit?": 126
"How do I lock and unlock the axes of a graph?": 128
"How do I change layer order of a display?": 130

Tables

"How do I reorder columns in a table?": 131
"How do I use a table to build data in Keep Mode?": 131

Text Boxes

"How do I enter subscripts, superscripts, Greek letters, and symbols?": 134
"How do I enter an equation into a text display?": 134
Scope

"How do I compare scope traces from the same sensor when monitoring?": 137
"How do I select the scope trigger?": 138
"How do I pre-trigger?": 141
"How do I freeze and record the Scope display?": 142

Video

"How do I add a video source?": 144
"How do I analyze a video?": 145
"How do I manually synchronize video with data?": 147
How do I adjust the exposure controls for video recording?
"How do I adjust the frame rate of a recorded video?": 148
"How do I adjust the resolution of a video?": 148
"How do I make files with videos smaller?": 149
"How do I troubleshoot video problems?": 149
How do I... Installation and Update

"How do I automate a network installation?": 71
"How do I force an update to an interface?": 71

How do I automate a network installation?

You must have a valid site license to perform a network installation. PASCO Capstone uses an InstallShield installer, which packages the Windows Installer (msi) into an executable setup file: PASCO_Capstone_Setup.exe. Both the InstallShield installer and the packaged msi can be controlled using command line switches: See InstallShield Note 1039936 for details on the InstallShield switches and Microsoft Note 227091 for information on the msi switches.

Below is an example of a silent installation:

1. Copy the installation file PASCO_Capstone_Setup.exe that you have either downloaded or obtained from a CD to the root directory of your hard drive “C”.
2. Go to Start > Run...
3. Type C:/PASCO_Capstone_Setup.exe /s /v"/qb". (/s = installer runs silently, /v = passes the parameter that follows immediately after in quotes to the msi installer, /qb = msi runs with no modal dialog boxes.)
4. Run the software.
5. Enter your license key when prompted.
6. After the license key is accepted, copy ResourceFiles.rc located at C:\Documents and Settings\All Users\Application Data\PASCO Scientific\ResourceFiles.rc (Windows XP) or C:\Program Data\PASCO Scientific\ResourceFiles.rc (Window 7) to the same location on the other computers by means of a batch copy command or other mechanism.

Contact "Teacher and Technical Support": 3 for instructions to install on Windows 8 and MAC.

How do I force an update to an interface?

PASCO Capstone prompts to update the interface if a new firmware version exists.

Follow these steps if an interface requires re-installing existing firmware to correct firmware corruption issues:

1. Unplug the interface from the USB port or turn it off.
2. Run PASCO Capstone.
3. Hold down CTRL+U while connecting or turning on the interface.
How do I... Experiment Files

"How do I download and open PASCO ready-made experiments?": 72
"How do I save my experiment?": 73
"How do I export all data?": 73
"How do I open DataStudio experiments and data?": 73
"How do I open Xplorer GLX, SPARK SLS, and other non-Capstone experiments and data?": 74
"How do I import data from Microsoft Excel*?": 74
"How do I export data to Microsoft Excel*?": 75
"How do I import Xplorer GLX data?": 76

How do I download and open PASCO ready-made experiments?

PASCO provides several ready-made experiments for Capstone. 👤Tip 1

1. Go to the Capstone experiments web page: http://www.-pasco.com/family/capstone-experiments/index.cfm
2. Select a subject area, for example Thermodynamics (Thermodynamics).
3. Select the Free Experiment Files (Free Experiment Files) tab.
4. Scroll through the list of ready-made experiments and click to download the experiment files.
5. Copy the files from your download folder to your Capstone experiments folder.
   The download might contain the following:
   - Capstone application files; these have a ".cap" file extension
   - Editable lab guides
   - Images
6. Open the *.cap file from Capstone.
   a. 👤Click File > Open Experiment....
   b. Navigate to the experiment file.
   c. 👤Click Open.

1The lab might contain multiple pages including: ◇ introduction ◇ theory ◇ setup & procedures ◇ analysis ◇ conclusions
How do I save my experiment?

Click **File > Save Experiment.**

All of the data, displays, toolbar states and formatting are saved.

**Note:** Deleted data and undo history are not saved.

How do I export all data?

1. Click **File > Export Data...**
2. Select a file type: **Text (Tab delimited) (*.txt); CSV (Comma delimited) (*.csv).**
3. Navigate to the location to save the file.
4. Click **Save.**

How do I open DataStudio experiments and data?

PASCO Capstone can open and convert most DataStudio 1.9 files to Capstone format.

How Do I Video

1. Click **File > Open Experiment...**
2. Click on the file type pull-down menu, and select: **DataStudio 1.9 files (*.ds).**
3. Click **Open.**
   - Capstone places each display from DataStudio on separate Capstone workbook pages.
   - Each display is sized to the full page.
   - Each page (tab) is named with the display name.
4. Recommended: save the experiment as a Capstone file. (See "How do I save my experiment?": 73)
5. Re-layout the Capstone pages as desired.
   - To combine multiple displays on a single page:
     a. Resize and move the display that will contain multiple displays to create a space for additional display(s). (See "Moving and resizing": 63)
     b. Click on page tab containing display to move.
c. Resize the display smaller than full page.

d. Select the display border, right-click and select Cut.

e. Click on the page, right-click and select Paste.

f. Resize and move as desired.

How do I open Xplorer GLX, SPARK SLS, and other non-Capstone experiments and data?

Xplorer GLX

How Do I Video

PASCO Capstone can open and convert most Xplorer GLX files to Capstone format. (For files resident on the Xplorer GLX: see "How do I import Xplorer GLX data?": 76)

1. Click File > Open Experiment...

2. Click on the file type pull-down menu, and select: GLX Files (*.glx)

3. Click Open.

4. Recommended: save the experiment as a Capstone file. (See "How do I save my experiment?": 73)

Xplorer and 500 Dataloggers

Consult with: "Teacher and Technical Support": 3

SPARK SLS Experiments

Consult with: "Teacher and Technical Support": 3

How do I import data from Microsoft Excel*?

Tip

1. Open Microsoft Excel* with the file containing your data.
2. Highlight the data within one column.

---

1 Capstone supports export as tab-delimited text, which can be imported into almost any spreadsheet or data analysis program. Note that Capstone is a complete data collection, visualization, and analysis tool; therefore, it is generally easier to analyze the data in Capstone than to export to another software program for analysis.
3. Press **CTRL+C** to copy the data.
4. Open PASCO Capstone.
5. Create a **Table**. (See "Adding a display": 61)
6. Click **<Select Measurement>** in a column.
7. Click **Create New > User-Entered Data**.
8. Optional: Rename the measurement and give it appropriate units.
9. Click in the cell of the **User-Entered Data** column where you would like to have the data pasted.
10. Press **CTRL+V** to paste.
11. Repeat for additional columns of data.

Each column of data is a separate data set.

Imported data are listed in the **User-Entered Data Summary** tab (****) of **Data Summary**.

**How do I export data to Microsoft Excel***?

ıpTip

**Export All Data**

How Do I Video

1. Click **File > Export Data**...
2. Select **CSV (comma delimited)** as the file type.
3. Enter a file name.
4. Click **Save**.

**Export Selected Data**

1. Create a **Table**. (See "Adding a display": 61)
2. Select the data that you would like to copy:

---

1^Capstone supports export as tab-delimited text, which can be imported into almost any spreadsheet or data analysis program. Note that Capstone is a complete data collection, visualization, and analysis tool; therefore, it is generally easier to analyze the data in Capstone than to export to another software program for analysis.
How do I import Xplorer GLX data?

Note: For Xplorer GLX files on the host computer: see "How do I open DataStudio experiments and data?": 73

To transfer experiments (including data files) from the Xplorer GLX to Capstone:

1. Connect the Xplorer GLX to Capstone.

2. Click Hardware Setup in the Tools Palette: 

![Hardware Setup](image)

3. Click the yellow file folder icon next to the Xplorer GLX: 

   ![Yellow Folder](image)
4. Click **Download All**.

5. Navigate a folder and click **Select Folder**.

6. Click **File > Open Experiment...**

7. Select **GLX Files (*.glx)** from the file type drop down.

8. Navigate to the saved file.

9. Click **Open**.

   Capstone opens the experiment and data for analysis and further data acquisition.
How do I... Data and Measurements

"How do I record data in PASCO Capstone?": 78
"How do I delete data runs?": 83
"How do I choose one or more runs to display?": 84
"How do I identify a measurement when I have multiple of the same type?": 85
"How do I change the numerical format of data?": 86
"How do I change the numerical format of statistics?": 88
"How do I exclude, delete, and restore selected data?": 89
"How do I edit a measurement?": 92
"How do I create a pure mathematical function?": 92

How do I record data in PASCO Capstone?

There are three data recording modes in PASCO Capstone. Data recording is controlled by the settings on the record tab of the Controls Palette.

<table>
<thead>
<tr>
<th>Record modes</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Record modes" /></td>
</tr>
<tr>
<td><strong>Continuous Mode</strong></td>
</tr>
<tr>
<td><strong>Keep Mode</strong></td>
</tr>
<tr>
<td><strong>Fast Monitor Mode</strong></td>
</tr>
</tbody>
</table>

Detailed Explanations

**Continuous Mode**

Set to record data at the current sample rate settings
Behavior

- All measurement Data continuously records as soon as Record is clicked in the Controls Palette until the Stop is clicked (or the hardware is no longer able to process the data—at which time data collection will stop with an error message).
- Data records at the specified sample rate(s).

🔗 See "What is Continuous Mode?": 165

Procedure

1. Select Continuous Mode in the Controls Palette.
2. Adjust the sample rates of each of the measurements:
   - Ensure sensors are sufficiently responsive for desired data while low enough so that the computer system can keep up with data sampling and does not generate excessive file sizes.

3. Click Record in the Controls Palette.

4. Capstone begins recording all available data.
   - Record toggles to Stop.

5. Click Stop in the Controls Palette to stop data collection.
   - Collected data appear in all displays of the current page.
   - The data run is listed in the legend for each display.

1 A data set including measurement and user-defined data from sensors and time data.
Recorded data appear on the **Sensor Data Summary** tab (RTL) in **Data Summary**, and is selectable from any data display with a default name **Run #%1**, where %1 is an automatically generated run number.

**Keep Mode**

Set to keep data points when commanded

**Behavior**

- Manual recording mode.
- The measurement sample rate(s) determine the rate at which data samples are **previewed** (not recorded).
- **Data**\(^1\) records when and only when **Keep Sample ✔** is clicked in the **Controls Palette** while monitoring data.
- One instance of all data is recorded each time **Keep Sample ✔** is clicked.

**Procedure**

📍Tip: You can use a table with **Keep Mode** to build data for specific points. (🔗 See "How do I use a table to build data in Keep Mode?": 131)

1. Select **Keep Mode** in the **Controls Palette**.
2. Adjust the sample rates of each of the measurements so that the sensors are sufficiently responsive for desired data.

3. Click **Preview ✅** in the **Controls Palette**.

\(^1\)A data set including measurement and user-defined data from sensors and time data.
Capstone begins monitoring data and displays previews.

- Preview toggles to Stop.
- Keep Sample is active.

4. Click Keep Sample to record the data currently monitored.
   - One instance of all data is recorded.

5. Repeatedly click Keep Sample to record data.
   - The cursor advances to the next table cell on each Keep Sample.
   - One instance of all data is recorded with each Keep Sample.

6. Optional: Replace values in a table. (See "Replacing a current value in a table": 132.)

   **Note:** You can replace data in tables while in preview mode for the run before stopping data collection (Stop).

   See "How do I edit a measurement?": 92 to edit data after stopping data collection.

7. Click Stop in the Controls Palette to stop observing the data.
   - Collected data appear in all displays of the current page.
   - The data run is listed in the legend for each display.
   - Recorded data appear on the Sensor Data Summary tab in Data Summary, and is selectable from any data display with a default name Run %1, where %1 is an automatically generated run number.

**Fast Monitor Mode**

Set to acquire data without recording; required for high speed sampling in Scope and FFT displays
Behavior

- Intended for use with workbooks pages containing the FFT or Scope displays.
- Designed for viewing periodic data or triggered transient events.
- Monitor displays data without recording.
- Snapshot records the monitored data.
  - Only Data\(^1\) that is currently visible in the display is recorded each time Snapshot is clicked.
  - Unsaved buffer data is also recorded when closing Capstone.
- Can repeatedly monitor and record data points.

See "What is Fast Monitor Mode?": 166

Procedure

1. Select Fast Monitor Mode in the Controls Palette.
2. Adjust the sample rates of each of the measurements so that the sensors are sufficiently responsive for desired data.

![Sample Rate](image)

3. Select one or more scope or FFT displays. (See "Adding a display": 61)

Note: To record a single event, use the scope display and select Single Shot. (See "What does Single Shot do?": 175)

4. Click Monitor in the Controls Palette.

![Monitor](image)

\(^1\) A data set including measurement and user-defined data from sensors and time data.
5. **Click** **Stop** in the **Controls Palette** to stop observing the data.

![Monitor stop](image)

Capstone freezes the display.

6. Scale the data to fit the data to record within the displays. 
   (See "How do I pan and scale?": 117)

7. **Click** **Snapshot** in the scope toolbar.

![Scope Toolbar: Snapshot](image)

Capstone records the data.

**Notes:**
Only the data that is visible in the plot area is recorded as a run when Snapshot is clicked. Recorded data appear on the sensor tab in the **Data Summary** tab (.), and is selectable from any data display with a default name **Monitor Run--ScopeSnapshot%1** where %1 is an automatically generated run number and %2 is the ordinal (1, 2, 3...) (For example: Run #1-ScopeSnapshot2 is the second snapshot of the first run).

**How do I delete data runs?**

- **Delete Last Run:** **Click** **Delete Last Run** in the **Controls Palette**.

- **Delete Selected Runs:** **Click** the down arrow next to **Delete Last Run** and select a specific run.
- **Delete All Runs**: Click the down arrow next to Delete Last Run and select Delete All Runs. 📡 Tip

**Note**: The run data is removed from all displays, legends, and the data summary. 📡 Click Undo at the top to recover the data.

---

**How do I choose one or more runs to display?**

By default, PASCO Capstone displays the last run recorded or the currently selected measurement in Replay mode.

To select a different run to display:

1. Click the pull-down arrow (▼) next to Run Selection in the toolbar.

   **Toolbar: Run Selection**
   
   ![Toolbar: Run Selection](image)

   Allow simultaneous viewing of multiple data sets | Select visible data

2. Select the run to display.

To display multiple runs:

1. Click to depress Run Selection in the toolbar.

   **Toolbar: Run Selection**
   
   ![Toolbar: Run Selection](image)

   Allow simultaneous viewing of multiple data sets | Select visible data

   Selected runs display simultaneously.

2. Click the pull-down arrow (▼) next to Run Selection in the toolbar.
3. Select the one or more runs to display.

---

¹You can delete all data for the run and repeat data collection.
How do I identify a measurement when I have multiple of the same type?

One instance of a measurement

Format for a single instance of a specific measurement:

*Measurement Type (units)*

Example: **Force (N)**

Multiple instances of measurement–one interface connected

Format for multiple instances of a specific measure with one interface connected:

*Measurement Type, Port (units)*

Example: **Force, Ch P1 (N)**

Where:
- Measurement Type = Force
- Port on interface = P1 (Port identifier on the interface "P1" → PASPORT sensor number 1)

Multiple instances of measurement–multiple interfaces connected

Format for multiple instances of a specific measure with multiple interfaces connected:

*Measurement Type, Channel:Port (units)*

Example: **Force, Ch A:P1 (N)**

Where:
- Measurement Type = Force
- Channel = A (Interface identifier "A")
- Port = P1 (Port identifier on the interface "P1" → PASPORT sensor number 1)
Setup with multiple interfaces

Data Summary

1. Force, Ch A:P1 (N)
2. Force, Ch A:P2 (N)
3. Force, Ch B:1 (N)

How do I change the numerical format of data?

Note: Changing data precision correspondingly changes the precision of statistics that use the data.
1. Click **Data Summary** in the **Tools Palette**.

![Data Summary](image)

2. Click the **Sensor Data** tab.

3. Click the measurement to change.

4. Click **Properties** that appears to the right of the measurement.
   
The Properties window opens.

5. Click **Numerical Format**.

6. Set the desired numerical format:

<table>
<thead>
<tr>
<th>Numerical Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Decimal Places</td>
<td>Set the number of digits that will appear to the right of the decimal.</td>
</tr>
<tr>
<td>Apply Scientific Notation</td>
<td>Select to enable Scientific Notation Thresholds</td>
</tr>
<tr>
<td>Thresholds</td>
<td></td>
</tr>
<tr>
<td>Scientific Notation Thresholds</td>
<td>Determines when the unit range transitions into scientific notation.</td>
</tr>
<tr>
<td>Lower Exponent Threshold ≤</td>
<td>Apply limits for which the unit range transitions into scientific notation.</td>
</tr>
<tr>
<td>Upper Exponent Threshold ≥</td>
<td></td>
</tr>
<tr>
<td>Apply Zero Level Thresholds</td>
<td>Select to enable Apply Zero Level Thresholds</td>
</tr>
<tr>
<td>Apply Zero Level Thresholds</td>
<td>Apply the limit under which the number is considered to be zero.</td>
</tr>
</tbody>
</table>

7. Click **OK**.
How do I change the numerical format of statistics?

**Note:** Changing data statistics precision correspondingly changes the precision of data.

To change the numerical format of the statistics, change the numerical format of the data on which the statistics are based.

1. ✉️ Click **Data Summary** 📊 in the **Tools Palette**.

2. ✉️ Click the **Sensor Data** tab 📊.

3. ✉️ Click the measurement to change.

4. ✉️ Click **Properties** 🪐 that appears to the right of the measurement.
   The **Properties** window opens.

5. ✉️ Click **Numerical Format**.
6. Set the desired numerical format:

<table>
<thead>
<tr>
<th>Numerical Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Decimal Places</td>
<td>Set the number of digits that will appear to the right of the decimal.</td>
</tr>
<tr>
<td>Apply Scientific Notation Thresholds</td>
<td>☑ Select to enable Scientific Notation Thresholds</td>
</tr>
<tr>
<td>Scientific Notation Thresholds</td>
<td>Determines when the unit range transitions into scientific notation.</td>
</tr>
<tr>
<td>Lower Exponent Threshold ≤</td>
<td>Apply limits for which the unit range transitions into scientific notation.</td>
</tr>
<tr>
<td>Upper Exponent Threshold ≥</td>
<td></td>
</tr>
<tr>
<td>Apply Zero Level Thresholds</td>
<td>☑ Select to enable Apply Zero Level Thresholds</td>
</tr>
<tr>
<td>Apply Zero Level Thresholds</td>
<td>Apply the limit under which the number is considered to be zero.</td>
</tr>
</tbody>
</table>

7. ☑ Click OK.

**How do I exclude, delete, and restore selected data?**

**Note:** You can create User-Entered Data to copy and edit/delete data in the list. (See "How do I edit a measurement?": 92)

Table

1. Highlight cells (☐ click one cell or ☐ click and drag across multiple cells ☑ Tip\(^1\)).
2. Exclude Selected Data: ☐ Right-click and select **Exclude Data**.
3. Delete Selected Data: ☐ Right-click and select **Delete Cell Data**.

**Note:** Excluded data are masked in the data set and are not used by Capstone for data operations including display and calculations. Excluded data can be restored at any time.

**Note:** Deleted data are removed from the data set and the data cannot be restored at a later time. You can immediately undo a delete action by clicking **Undo**.

\(^1\)Click the table heading to highlight all data in the table column.
### Deleted and Excluded Data in a Table

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0.900</td>
<td>0.30</td>
</tr>
<tr>
<td>0.950</td>
<td>0.26</td>
</tr>
<tr>
<td>1.000</td>
<td>0.25</td>
</tr>
<tr>
<td>1.050</td>
<td>0.19</td>
</tr>
<tr>
<td>1.100</td>
<td>0.18</td>
</tr>
<tr>
<td>1.150</td>
<td>0.18</td>
</tr>
<tr>
<td>1.200</td>
<td>0.18</td>
</tr>
<tr>
<td>1.250</td>
<td>0.21</td>
</tr>
<tr>
<td>1.300</td>
<td>0.28</td>
</tr>
<tr>
<td>1.350</td>
<td>0.35</td>
</tr>
<tr>
<td>1.400</td>
<td>0.42</td>
</tr>
<tr>
<td>2.200</td>
<td>0.42</td>
</tr>
</tbody>
</table>

1. Deleted data are removed. Note the gap in time data.
2. Excluded data display with strikethrough.

### Graph

1. Click **Highlight range of points in active data** in the toolbar.

   **Toolbar: Highlight Data**

   ![Toolbar](image)

   *Apply selected curve fits to active data | Select curve fits to be displayed*

2. Move and resize the selection rectangle as needed.

3. **Exclude Selected Data:** Right-click and select **Exclusions > Exclude Highlighted Data Points.**

4. **Delete Selected Data:** Right-click and select **Deletions > Delete Highlighted Data Points.**

5. **Delete Excluded Data:** Right-click and select **Deletions > Delete ALL Excluded Data Points.**

   **Note:** Excluded data are masked in the data set and are not used by Capstone for data operations including display and calculations. Excluded data can be restored at any time.
**Note:** Deleted data are removed from the data set and the data cannot be restored at a later time. You can immediately undo a delete action by clicking **Undo 🔄**.

**Deleted and Excluded Data in a Plot**

1. Deleted data are removed.
2. Excluded data display with "X" marks.

To restore excluded data

**Table**

1. Highlight excluded cells. 👤**Tip**
2. Right-click and select **Restored Excluded Data**.

**Graph**

1. Click **Highlight range of points in active data 📊** in the toolbar.
2. Move and resize the selection rectangle as needed to highlight excluded data points.
3. **Restore Selected Data:** Right-click and select **Exclusions > Restore Excluded Data Points Within Highlighter’s Bounds**.

---

1 Click the table heading to highlight all data in the table column.
4. **Restore All Data:** Right-click and select **Exclusions > Restore ALL Excluded Data Points**.

### How do I edit a measurement?

Measurements cannot be edited directly in PASCO Capstone. You can create **User-Entered Data** to copy and edit/delete data in the list.

**Note:** You can use Exclude Data to exclude selected data from analysis and Displays. (See "How do I exclude, delete, and restore selected data?": 89)

1. Create a **Table**. (See "Adding a display": 61)
2. Click **<Select Measurement>** in the first column.
3. Select the measurement you would like edit.
4. Click **<Select Measurement>** in the second column.
5. Click **Create New > User-Entered Data**.
6. Click on the top of the first column.
7. Right-click and select **Copy Values** (or use CTRL+C).
8. Click in the first cell of the **User Data %1** (where %1 is serial number) column.
9. Right-click and select **Paste Values** (or use CTRL+V).
10. Edit data in cells:
    a. Change values in cells as needed.
    b. Highlight cells and right-click to select: **Clear Values**, **Insert Cells**, **Delete Cell Data**, or **Exclude Data** as needed.
11. Click on **User Data %1** in the column heading, select rename, and enter a meaningful name and units.

Imported data are listed in the **User-Entered Data Summary** tab of **Data Summary**.

### How do I create a pure mathematical function?

Graph a purely mathematical function by defining a [model][1] and then creating a calculation on the model within the calculator.

---

[1]: A sequence of values within a range and a defined number of steps or step size.
Procedure

1. Create a model in the calculator.
   a. Open the Calculator. (See "How do I create a calculation?": 106)
   b. Right-click on a new calculation line and select **Insert Model Range**. The **Edit Model Range Properties** window opens.
   c. Set the **Start Value**: of the range.
   d. Set the **End Value**: of the range.
   e. Select option:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
<th>Example Format:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Count:</td>
<td>Set the number of values between the Start Value and End Value.</td>
<td>{0 .. 10;100}</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Start Value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0; End Value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10; Step Count: 100</td>
</tr>
<tr>
<td>Step Size:</td>
<td>Set the increment size between values in the range. A smaller step</td>
<td>{0 .. 10;+1}</td>
</tr>
<tr>
<td></td>
<td>size will produce more values in the range and a larger step size</td>
<td>Start Value:</td>
</tr>
<tr>
<td></td>
<td>will produce fewer values in the range.</td>
<td>0; End Value:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10; Step Size: 1</td>
</tr>
</tbody>
</table>

2. Click **OK**.

3. Insert an equation using the **Model** on a new calculation line. (See "How do I create a calculation?": 106)

   Calculations appear on the **Calculation Data Summary** tab (§) in Data Summary, and are selectable from any data display. (See "How do I use my calculation?": 109)

**Example in Calculator**

\[ y = \{0 .. 10;100\} \]
\[ z = \sin(y)^2 \]
\[ w = \text{integral}([y\text{(units)}],y) \]

**Where:**
- \( y \) is a model
- \( z \) and \( w \) are functions based on model \( y \).
How do I... Workbooks

"How do I show, hide, and lock the palettes?": 94

"How do I change which display types are available in the display toolbar?": 95

How do I show, hide, and lock the palettes?

1. Right-click anywhere in the gray area surrounding a workbook page.

2. Show/hide: click the palette that you would like to show (✓) or hide ( ).
3. Lock/unlock: 

- Click Lock Page to lock (🔒) or unlock page (🔓).

Locked pages:
- Displays cannot be added or removed.
- **Text Entry Box** elements are active and accept user entries.
- Displays can be scaled and panned.

**How do I change which display types are available in the display toolbar?**

1. 

- Click on **Visibility Menu** in the toolbar.

![Toolbar: Visibility Menu](image)

- If **Visibility Menu** is not available: 
  - Right-click anywhere in the gray area surrounding a workbook page and deselect **Lock Page**.
2. Click the display types that you would like to show (✓) or hide (□) on the tool-bar.
How do I show, hide, and lock the icons on the palettes?

1. Right-click anywhere in the gray area surrounding a workbook page.

2. Show/hide: click the palette that you would like to show (✓) or hide (■).

3. Lock/unlock: click Lock Page to lock (✓) or unlock page (■).
How do I... Sensors

"How do I zero a measurement?": 98
"How do I switch the sign on a sensor?": 99
"How do I calibrate a sensor?": 100
"How do I calibrate a motion sensor?": 101
"How do I calibrate a drop counter?": 102
"How do I calibrate a pH sensor?": 103

How do I zero a measurement?

**Note:** If a sensor is selected in the Controls Palette that supports zeroing, the Controls Palette includes the function: Zero Sensor Now.

**How Do I Video**

Procedure

1. Connect the sensor to PASCO Capstone. (See "Connecting a sensor": 33)

2. Click Hardware Setup in the Tools Palette.

   ![Hardware Setup](image)

   Configure interface and sensor hardware

3. Click on the sensor to zero.

4. Click Properties in the lower right corner of the Hardware Setup window.

   ![Properties](image)

   The Properties window opens.
5. Select option:

These options will not appear for sensors that do not have these capabilities.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero Sensor Measurements at Start</td>
<td>Zero this sensor's measurements each time a new run is recorded.</td>
</tr>
<tr>
<td>Zero Sensor Now</td>
<td>Zero this sensor's measurements when the button is clicked.</td>
</tr>
</tbody>
</table>

6. ✖️ Click OK.

How do I switch the sign on a sensor?

**Method 1: configuring sensor (that supports sign change)**

1. ✖️ Click Hardware Setup in the Tools Palette.

   ![Hardware Setup](image)

2. ✖️ Click on the sensor to Change Sign.

3. ✖️ Click Properties in the lower right corner of the Hardware Setup window.

4. The Properties window opens.

5. ✖️ Click Change Sign.

   ➡️ This option will not appear for sensors that do not have this capability.

6. ✖️ Click OK.

   ➡️ The sensor automatically switches the sign when recording data.
Method 2: using QuickCalc (any sensor)

1. Create a Table. (🔗 See "Adding a display ": 61)
2. ✂ Click <Select Measurement> and select the measurement to change sign.
3. ✂ Click QuickCalc in the toolbar.

_toolbar: QuickCalc

Create a new calculation on the selected column data

A new table column is added with a default calculation that includes the selected measurement.
4. Rename the calculation to something meaningful.
5. Add a negative sign in the calculation before the measurement.
   Example: ForceA= - [Force (N)]
6. Press Enter.
   The new column is the opposite sign of the original measurement data.
7. ✂ Click on the units in the new column and change to something meaningful.
   Calculations appear on the Calculation Data Summary tab (阅览) in Data Summary, and are selectable from any data display. (🔗 See "How do I use my calculation?": 109)

Method 3: using Calculator (any sensor)

Use the Calculator to create a calculation that changes the sign. (🔗 See "How do I create a calculation?": 106)

Example: ForceA= - [Force (N)]

Calculations appear on the Calculation Data Summary tab (阅览) in Data Summary, and are selectable from any data display. (🔗 See "How do I use my calculation?": 109)

How do I calibrate a sensor?

PASCO Capstone includes calibration wizards for many sensors.

Procedure
1. Connect the sensor to PASCO Capstone. (See "Connecting a sensor": 33)

2. Click **Calibration** in the **Tools Palette**.

3. Follow the instructions within Capstone.

   - Sensors that do not have a wizard in Capstone will not be listed.

   For detailed procedures, see:

   - "How do I calibrate a motion sensor?": 101
   - "How do I calibrate a pH sensor?": 103
   - "How do I calibrate a drop counter?": 102
   - "Can multiple measurements be calibrated simultaneously?": 172

### How do I calibrate a motion sensor?

1. Connect the Motion Sensor to PASCO Capstone. (See "Connecting a sensor": 33.

2. Place a marker at one meter from the face of the motion sensor.

3. Record the distance to the marker reported by the motion sensor.
4. Click **Data Summary** in the **Tools Palette**.

5. Click the **Sensor Data Summary** tab.

6. Click the **Motion Sensor** properties icon.

7. Divide the value in the **Speed of Sound (m/s)** field by the recorded distance in meters (from step 3).

8. Enter the calculated value (from step 7) in the **Speed of Sound (m/s)** field.

9. Click **OK**.

**How do I calibrate a drop counter?**

**How Do I Video**

1. Connect the Drop Counter to PASCO Capstone. (See "Connecting a sensor": 33)

2. Measure the volume from the Drop Counter for 10 drops.

3. Calculate the volume per drop (divide volume from step 2 by 10).

4. Click **Data Summary** in the **Tools Palette**.
5. 
   Click the **Sensor Data Summary** tab.

6. 
   Click on the Drop Counter properties icon.

7. 
   Enter the calculated value (from step 3) in the Drop Volume (mL) field.

8. 
   Click **OK**.

### How do I calibrate a pH sensor?

**Note:** Simultaneous calibration is not recommended for pH, ISE, ORP, Conductivity, stainless-steel temperature sensors without insulating sleeves, or Dissolved Oxygen sensors because these sensors will not read correctly if the probes are placed in the same solution simultaneously.

**Equipment Required**

Two aqueous pH buffer standards that bracket the pH values of interest.

**Procedure**

1. Connect the pH Sensor to PASCO Capstone. ([See "Connecting a sensor": 33](#))

2. 
   Click **Calibration** in the **Tools Palette**.
3. Choose the probes you would like to calibrate now: **pH Measurement**

4. **Click Next.**

5. Choose the type of calibration you would like to perform: **Two Standards (2 point).**

6. **Click Next.**

7. Enter the first known pH buffer value in the **Standard Value** text box.

8. Rinse and dry the pH Sensor probe.

9. Place the probe in the corresponding buffer solution.

10. Stir the probe until the **Current Value** stabilizes.

11. **Click Set Current Value to Standard Value.**

12. **Click Next.**

13. Enter the second known pH buffer value in the **Standard Value** text box.

14. Rinse and dry off the probe.

15. Place the probe in the second buffer solution.

16. Stir the probe until the value **Current Value** stabilizes.

17. **Click Set Current Value to Standard Value.**
18. Click Next.

19. Click Finish.

Repeat the calibration procedure for other pH sensors using different probes.
How do I... Calculations

"How do I create a calculation?": 106
"How do I use my calculation?": 109
"How do I select a measurement in the calculator?": 110
"How do I see the result of a calculation?": 110
"How do I reorder calculations?": 112

How do I create a calculation?

**Note:** Calculations appear on the Calculation Data Summary tab (строенное) in Data Summary, and are selectable from any data display. (See "How do I use my calculation?": 109)

**Tips**

- Capstone supports simple to highly-complex calculations using a combination of math functions, measurements, user-defined data, constants, and text labels including symbols.
- Use either the keyboard or the Calculator keypad for numbers and simple operators.
- Add parenthesis to explicitly define order of operation.
- Multiplication is implied with adjacent arguments. Insert the * symbol to explicitly denote multiplication.
- Type: [ to quickly insert measurements (or click Insert Data).

**Procedure**

1. Click Calculator in the Tools Palette.
2. Use a combination of measurements, text, calculator functions, and numerals to create a calculation.

The calculation is displayed Calculations list.

Invalid or incomplete calculations are indicated with red font.

See "How do I select a measurement in the calculator?": 110
See "How do I see the result of a calculation?": 110
See "How do I reorder calculations?": 112
See "How do I use my calculation?": 109

Example Procedure:

Define the following equation:

Where:

\[ x = \text{Position} \text{ (calculated)} \]
\[ a = \text{Acceleration} \text{ (measured)} \]
\[ v = \text{Velocity} \text{ (measured)} \]
\[ t = \text{Time} \text{ (measured)} \]
\[ x_0 = \text{initial position (user-created constant)} \]
1. Click **Calculator** in the Tools Palette.

The **Calculator** dialog opens.

2. Click in a new line of Calculations.

3. Create the constant \( x_0 \):
   a. Type: \( x \)
   b. Click \( x_0 \), select 0
   c. Type: =
   d. Type: 0

4. Click in a new line of **Calculations**

5. Type: \( x=1/2 \)

6. Type: [ (or click Insert Data).

   A pop-up list opens.

7. Select the appropriate Acceleration measurement from the drop down list.

8. Type: [ (or click Insert Data).

9. Select the Time measurement from the drop down list.
10. Click $x^2$.

11. Type: $+$ (or click $+$)

12. Type: $[$ (or click Insert Data $\Delta$).

13. Select the appropriate Velocity measurement from the drop down list.

14. Type $[$ (or click Insert Data $\Delta$).

15. Select the **Time** measurement from the drop down list.

16. Type: $+$ (or click $+$)

17. Type: $[$ (or click Insert Data $\Delta$).

18. Select the Constants (under Equations/Constants) measurement from the drop down list.

19. Select $x_0$.

20. Click in the **Units** field.

21. Type: $m$ and select $m/s^2$ from the list.

22. Press **Enter** or **Accept $\checkmark$**.

### Example Calculations

**Constant1=2*3**

**Calc1=[Acceleration(m/s²)]^2**

**Γ^2=sin([Angle(rad)])**

**Φ=integral([Force(N)],[Time(s)])**

**Resultant Acceleration=sqrt(([Acceleration_x(m/s²)]^2+[Acceleration_y(m/s²)]^2+[Acceleration_z(m/s²)]^2))**

### How do I use my calculation?

**Note:** Calculations appear on the Calculation Data Summary tab ($\mathbb{S}$) in Data Summary, and are selectable from any data display. ($\checkmark$See "How do I use my calculation?": 109)
1. Create a calculation. (See "How do I create a calculation?": 106)
2. Click <Select Measurement> in any display.
3. Select the calculation or constant to use under **Equations/Constants**.
4. Select the run to display. (See "How do I choose one or more runs to display?": 84)

**How do I select a measurement in the calculator?**

**Method 1**

1. Position cursor for placement of measurement.
2. Click **Insert Data**. ➔ A pop-up list opens.
3. Select the measurement from the list.

**Method 2**

1. Right-click anywhere within the calculation to place the measurement. ➔ A pop-up menu opens.
2. Select **Insert Data** from the menu.
3. Select the measurement from the list.

**Method 3**

1. Position cursor for placement of measurement.
2. Enter a left-bracket “[“.
   ➔ A pop-up list opens.
3. Select from the measurement from the list.

**How do I see the result of a calculation?**

**Note:** Calculations appear on the **Calculation Data Summary** tab ( ) in **Data Summary**, and are selectable from any data display. (See "How do I use my calculation?": 109)

**Constants Only**

If the calculation uses constants (no measurements) such that the calculation evaluates
to a single number, then the result of the calculation is displayed in the result status line.

Constants can also be viewed in a table or other display, see below.

**Includes Variables (measurements)**

The results are calculated using MathML and are associated with data runs. Calculated data can be viewed in a table or other display.

1. Create a calculation. (See "How do I create a calculation?": 106)
2. Click **Select Measurement** in any display.
3. Select the calculation or constant to use under **Equations/Constants**.
4. Select the run to display. (See "How do I choose one or more runs to display?": 84)

**Example Calculations**

**Constant1** = 2*3

**Calc1** = [Acceleration(m/s²)]^2

Γ^2 = sin([Angle(rad)])

Φ = integral([Force(N)],[Time(s)])
Resultant Acceleration=$\sqrt{([\text{Acceleration}_x \text{ (m/s}^2\text{)}]^2+[\text{Acceleration}_y \text{ (m/s}^2\text{)}]^2+[\text{Acceleration}_z \text{ (m/s}^2\text{)}]^2)}$

How do I reorder calculations?

Method 1

1. 📩 Click and drag the calculation that you would like to move.
2. When the colored insert line is at the desired insertion point, release the mouse button.

Method 2

1. 📩 Click the calculation that you would like to move to select it.
2. Use the arrow keys in the Calculator window.
How do I... Plots

"How do I plot multiple measurements on separate plot areas with shared X-axis?": 114
"How do I zoom to a selection?": 115
"How do I pan and scale?": 117
"How do I select active data?": 118
"How do I plot multiple measurements on same plot with multiple Y-axes?": 120
"How do I plot multiple measurements on same plot with same Y-axes?": 122
"How do I apply a curve fit to a portion of the data?": 124
"How do I change curve fit parameters?": 125
"How do I adjust the weights for the weighted linear fit?": 126
"How do I lock and unlock the axes of a graph?": 128
"How do I change layer order of a display?": 130
How do I plot multiple measurements on separate plot areas with shared X-axis?

**Attributes of multiple plot areas**

1. The plots share the same x-axis measurement.
2. The y-axes are independent.
3. The plots from the different measurements do not overlap.

![Graph showing three separate plots with shared x-axis]

*See "How do I plot multiple measurements on same plot with multiple Y-axes?": 120*

*See "How do I plot multiple measurements on same plot with same Y-axes?": 122*

**Procedure**

1. Click **Add new plot area to the Graph display** in the toolbar.

   ![Toolbar: Add New Plot]

2. Click **<Select Measurement>** on the plot and choose the measurement for the vertical axis.
3. To delete a plot area and its corresponding plots, ![click on the plot area and ![click Remove active element, axis, or plot area](X).

**Note:** You will not be allowed to have fewer than one plot area. Use **Delete Selected Display** ![in main toolbar to remove the display.](X) (Scope display does not allow multiple plots.)

**How do I zoom to a selection?**

**Zoom in**

1. If multiple runs are visible, ![click on the symbol corresponding to the plot to zoom in the legend.](X)

**Legend: selecting the active plot**

- ![Symbol and color in legend matches plot symbol and color. ![Click the legend to make active. (The active plot is shaded in legend and darkest in display.)](X)
- ![Click in the upper left corner of the legend to clear all active runs.](X)

2. ![Click **Data Highlighter** ![in the toolbar.](X)

**Toolbar: Highlight Data**

Apply selected curve fits to active data | Select curve fits to be displayed
A rectangle appears on the graph that is the same color as the target plot.

3. Click and drag anywhere within the highlighter to move it.

4. Click and drag the handles to resize the highlighter rectangle to the area to zoom.

Selected data is highlighted in yellow.

5. Click **Scale to Fit** in the toolbar.

![Toolbar: Scale-to-fit](image)

The plot zooms to the selected section.

6. Optional: Remove the highlight rectangle:
   a. Click the highlight rectangle
   b. Press **Delete** to remove the rectangle

**Zoom out**

1. Remove the highlight rectangle:
   a. Click the highlight rectangle
   b. Press **Delete** to remove the rectangle

2. Click **Scale to Fit** in the toolbar.

![Toolbar: Scale-to-fit](image)

The plot zooms out to include all data.
How do I pan and scale?

Panning

Moving the origin within the display. Scale does not change.

1.  Click within the plot area (except for the legend) and drag the plot in any direction.
2.  Release the mouse button when the origin is in the desired location.

Scaling

Changing the axis scale (value between tick marks) to zoom-in or zoom-out. Origin does not change.

bullet Click and Drag Method

1.  Click on an axis to scale.
2.  Drag away from origin to decrease scale (zoom-in).
3.  Drag toward the origin to increase scale (zoom-out).

Scroll Wheel Method

Note: If the plot does not pan or scale: see "How do I lock and unlock the axes of a graph?": 128.
1. Move the cursor to a location on an axis to scale.
2. Scroll back to decrease scale (zoom-in).
3. Scroll forward to increase scale (zoom-out).

Scaling is performed on the axis at the point of the cursor.

Tip

Zooming around a point

Changing the scale and origin around a single point.

1. Move the cursor to a location on a point to remain stationary (except for the legend).
2. Scroll back to decrease scale (zoom-in).
3. Scroll forward to increase scale (zoom-out).

How do I select active data?

By default, the last selected measurement of the last run is the active run.

To make another plot active:

- Click on the symbol corresponding to that plot in the legend (1 in the example)).
Legend: selecting the active plot

1. Symbol and color in legend matches plot symbol and color. 📰 Click the legend to make active. (The active plot is shaded in legend and darkest in display.)

2. 📰 Click in the upper left corner of the legend to clear all active runs.

To clear all active runs:

- 📰 Click in the upper left corner of the legend (2 in the example).

Legend: selecting the active plot

1. Symbol and color in legend matches plot symbol and color. 📰 Click the legend to make active. (The active plot is shaded in legend and darkest in display.)

2. 📰 Click in the upper left corner of the legend to clear all active runs.

Toolbars (including data functions):
Toolbars are active when a single display is active, and will only apply to the active display.

For displays with multiple plots, the toolbar actions apply to the active plot within the display.

How do I plot multiple measurements on same plot with multiple Y-axes?

Attributes of multiple Y-axes

1. Measurements scale independently (except for the rescaling required to make the alignment of the tick mark values on each side of the graph match up).
2. The order of the axes may be changed once multiple axes are created.
3. Plots from different measurements use the same plot area and may overlap.

See "How do I plot multiple measurements on separate plot areas with shared X-axis?": 114

See "How do I plot multiple measurements on same plot with same Y-axes?": 122

Procedure

1. Create a graph display. (See "Adding a display": 61)
2. Click Add new y-axis to active plot area. (Click multiple times to add multiple axes.)
3. Click <Select Measurement> and choose the measurements for each vertical axis.

4. Optional: reorder axes:
   a. Click Allow rearrangement of axes and plot areas in the toolbar.
   b. Drag and drop axes one at a time.
      - Axes can reside on the left, right, or a combination of both sides of the display.
   c. Click Allow rearrangement of axes and plot areas.
      - Exits re-arrangement mode.

Remove an axis

- Click on axis to remove. (Must not be in re-arrangement mode.)
- Click Remove active element, axis, or plot area.

Note: You will not be allowed to have fewer than one plot area. Use Delete Selected Display in main toolbar to remove the display. (Scope display does not allow multiple plots.)
How do I plot multiple measurements on same plot with same Y-axes?

PASCO Capstone allows one measurement on the x (independent variable) axis and multiple measurements on the y (independent variable) axis. Y-axis labels can be placed on either side. If the measurements share the same measurement type, then the measurements can be plotted with a shared Y-axis.

Attributes of multiple measurements with a shared Y-axis

1. Measurements must share the same measurement type. The shared generic Measurement Type name is displayed on the Y-axis.

2. Measurements scale together.

3. Plots from different measurements use the same plot area and may overlap.

See "How do I plot multiple measurements on separate plot areas with shared X-axis?": 114

See "How do I plot multiple measurements on same plot with multiple Y-axes?": 120

Procedure

1. Create a graph display. (See "Adding a display": 61)

2. Click Select Measurement and select one of the measurements to display on the vertical Y-axis.

3. Click Data Summary in the Tools Palette.
4. Click the **Sensor Data** tab.

5. Click and drag another measurement of the *same measurement type* to the graph display.

6. Repeat for additional sensors of same type.
   - The shared generic **Measurement Type** name is displayed on the Y-axis.
How do I apply a curve fit to a portion of the data?

1. Select the plot to fit by clicking on its corresponding symbol in the legend.

![Legend: selecting the active plot]

- Symbol and color in legend matches plot symbol and color. Click the legend to make active. (The active plot is shaded in legend and darkest in display.)
- Click in the upper left corner of the legend to clear all active runs.

2. Click **Data Highlighter** in the toolbar.

![Toolbar: Highlight Data]

- A rectangle appears on the graph that is the same color as the target plot.

3. Click and drag anywhere within the highlighter to move it.

4. Click and drag the handles to resize the highlighter rectangle.

5. Click the down arrow (▼) on **Curve Fit**

6. Select the curve fit that you wish to apply to the selected data from the pull-down menu.
How do I change curve fit parameters?

PASCO Capstone supports modifying curve fit parameters for high-precession fits. (Initial curve fits are usually automatic and accurate.)

Procedure

1. If not visible, show the Curve Fit Editor 🌟 in the Toolbar. (See "How do I show, hide, and lock the palettes?": 94)

2. Select the plot to fit by clicking on its corresponding symbol in the legend.
Legend: selecting the active plot

1. Symbol and color in legend matches plot symbol and color. 🗑️ Click the legend to make active. (The active plot is shaded in legend and darkest in display.)

2. 🗑️ Click in the upper left corner of the legend to clear all active runs.

3. 🗑️ Click Curve Fit Editor 🆕️ in the Toolbar.
4. Enter the value to modify in the Initial Guess box of the corresponding parameter.
5. 🗑️ Click the Lock check box (✓) next to parameter.
   - Locks the manual entry. Capstone will not overwrite.
6. Repeat for each parameter to modify.
7. 🗑️ Click Update Fit.
   - The curve fit in the graph uses the manually entered values.
   - Repeat steps to iteratively improve the curve fit.
   - To reset to default settings and unlock parameter values, 🗑️ click Reset.
8. 🗑️ Click Curve Fit Editor 🆕️ in the Toolbar to close the editor.

How do I adjust the weights for the weighted linear fit?

The weights for the weighted linear fit come from the errors in the data set. To define the error associated with each data value:
1. Click **Data Summary** in the **Tools Palette**.

*Data Summary*

2. Click the **Sensor Data** tab.

3. Click the measurement to change.

4. Click **Properties** that appears to the right of the measurement.
   - The **Properties** window opens.

5. Click the **Errors** section.

6. Define the error type and values.

<table>
<thead>
<tr>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Absolute Error</td>
<td>Specifies the default absolute error value for this measurement and is used when Default Errors are in effect.</td>
</tr>
<tr>
<td>Default Minimum Display Value</td>
<td>Sets the default minimum scale value for this measurement when it is initially selected in some data displays.</td>
</tr>
<tr>
<td>Default Maximum Display Value</td>
<td>Sets the default maximum scale value for this measurement when it is initially selected in some data displays.</td>
</tr>
<tr>
<td>Error Bar Type</td>
<td>Select the type of error bar to display. Choose Default Error to set the length of the error bars equal to the default absolute error of the data. Choose Percent of Value to set the length of the error bars equal to the specified percentage of each data point value. Choose</td>
</tr>
</tbody>
</table>
### Error Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Range</td>
<td>to set the length of the error bars to equal specific values. Choose Measurement to use a User Entered Data Set or other Measurement to define error values for individual data points.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the error settings for this measurement to defaults.</td>
</tr>
</tbody>
</table>

#### How do I lock and unlock the axes of a graph?

PASCO Capstone has several options for locking the axes of a graph from **Panning** and **Scaling**.

#### Lock panning or scaling from both user and data changes

1. Deselect **Scaling Method** in the Display Toolbar.

   ![Toolbar: Scaling Method](image)

   - Capstone will not scale to the data.

2. Right-click on an axis and select one or both:
   - **Lock Axis Panning**
   - **Lock Axis Scale**
Users cannot manually pan or scale.

3. Optional: repeat for additional axes.

4. Click **Show or hide tools** in the Display Toolbar.

5. Deselect **Scale to Fit** in the list.

Users cannot scale to fit.

6. Click anywhere in Capstone to close **Show or hide tools**.

**Lock scaling from data changes only**

Deselect **Scaling Method** in the Display Toolbar.

Capstone will not scale to the data.

**Lock panning or scaling from user changes only**

1. Right-click on an axis and select one or both:
   - **Lock Axis Panning**
   - **Lock Axis Scale**

Users cannot manually pan or scale.

2. Optional: repeat for additional axes.

3. Click **Show or hide tools** in the Display Toolbar.
4. Deselect Scale to Fit in the list.
   ➔ Users cannot scale to fit.

5. ➔ Click anywhere in Capstone to close Show or hide tools.

How do I change layer order of a display?

1. ➔ Click on the display to make it active. (See "How do I select active data?": 118)
2. ➔ Right-click on the border of the display.
3. Select: Send To Back or Bring To Front.
   ➔ Send To Back = places display at the bottom of the stack.
   ➔ Bring To Front = places display at the top of the stack.
How do I... Tables

"How do I reorder columns in a table?": 131
"How do I use a table to build data in Keep Mode?": 131

How do I reorder columns in a table?

1. Click on an empty part of the column header.
2. Drag until the blue column marker indicates the desired location for the column.
3. Release the mouse button.

How do I use a table to build data in Keep Mode?

Procedure

1. Create a table for the measurement to capture. (See "Adding a display": 61)
2. Optional: Create User-Entered Data into one column of the table.
3. Click in the first cell to record data.
4. Select 🎨 Keep Mode in the Controls Palette.
5. Adjust the sample rates of each of the measurements so that the sensors are sufficiently responsive for desired data.

6. Click Preview in the Controls Palette.
5 How do I... Tables

Capstone begins monitoring data and displays previews.
Preview ☑ toggles to Stop ■.
Keep Sample ✔ is active.

7. Click Keep Sample ✔ to record the data currently monitored.
   ➤ One instance of all data is recorded.
   ➤ The cursor advances to the next table cell.

![Keep Sample](image)

8. Repeatedly 🖥 click Keep Sample ✔ to record data.
   ➤ The cursor advances to the next table cell on each Keep Sample.
   ➤ One instance of all data is recorded with each Keep Sample.

9. Optional: Replace values in a table. (See "Replacing a current value in a table": 132.)

   ![Note](image)

10. Click Stop ■ in the Controls Palette to stop observing the data.
    ➤ Collected data appear in all displays of the current page.
    ➤ The data run is listed in the legend for each display.
    ➤ Recorded data appear on the Sensor Data Summary tab (смотрите) in Data Summary, and is selectable from any data display with a default name Run #%1, where %1 is an automatically generated run number.

**Replacing a current value in a table**

1. While previewing data, 🖥 click in the cell to change.
   ➤ The current monitored value is displayed with the existing value.
Replace data in table cell

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2.926</td>
<td>2.926</td>
<td>2.926</td>
</tr>
<tr>
<td>3.013</td>
<td>3.013</td>
<td>3.013</td>
</tr>
<tr>
<td>3.062</td>
<td>3.062</td>
<td>3.062</td>
</tr>
<tr>
<td></td>
<td>3.087</td>
<td>3.087</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing value</td>
<td>New value</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

Click Keep Sample to replace the existing value with the new value.

The cursor advances to the next table cell.

3. Perform one of the following options:
   - Continue to replace values.
   - Click in empty cell to record additional data.
   - Click Stop in the Controls Palette to stop observing the data.

**Note:** You can replace data in tables while in preview mode for the run before stopping data collection (Stop).

See "How do I edit a measurement?": 92 to edit data after stopping data collection.
How do I... Text Boxes

"How do I enter subscripts, superscripts, Greek letters, and symbols?": 134
"How do I enter an equation into a text display?": 134

How do I enter subscripts, superscripts, Greek letters, and symbols?

New: enter subscripts, superscripts or symbols

1. Right-click in any area that accepts text such as: text box, text entry, name, or calculator fields.
2. Select one of the following:
   - Insert Superscript
   - Insert Subscript
   - Insert Upper Case Greek Letter
   - Insert Lower Case Greek Letter
   - Insert Special Character
3. Select the character to insert from the drop-down list.

Existing: subscript or superscript selected text (text and text entry boxes only)

1. Highlight existing text.
2. Right-click and select one of the following:
   - Superscript Selected Text
   - Subscript Selected Text

How do I enter an equation into a text display?

1. Create the equation using an application capable of exporting MathML as plain text.
2. Paste into a Text Box or Text Entry Box in PASCO Capstone. (See "Adding a display": 61)


1. Switch to MathML mode (if needed):
a. Click **Insert > Equation > Insert new equation**.

b. Select the arrow at the lower right of the tools part of the ribbon.

c. Select **Copy MathML to the clipboard as plain text**
2. Type the equation in the programs equation editor.
3. Highlight the equation.
4. Press \texttt{CTRL+C} to copy.
5. Switch to a \textbf{Text Box} or \textbf{Text Entry Box} in Capstone.
6. Place the cursor and press \texttt{CTRL+V} to paste.
How do I compare scope traces from the same sensor when monitoring?

1. Select one of the traces that you would like to compare with later traces by clicking on the symbol corresponding to that plot in the legend.

Legend: selecting the active plot

1. Symbol and color in legend matches plot symbol and color. 🗼 Click the legend to make active. (The active plot is shaded in legend and darkest in display.)

2. 🗼 Click in the upper left corner of the legend to clear all active runs.

2. 🗼 Click **Snapshot** 🎥 in the toolbar to capture the visible trace.
3. Click **Run Selection**.
   Multiple runs can display simultaneously.

4. Click the pull-down arrow (▼) next to **Run Selection** in the toolbar.

5. Select the measurement trace snapshots that you would like to display.

🔗 See "How do I record data in PASCO Capstone?": 78

**How do I select the scope trigger?**

**Note:** If the trigger in the scope toolbar is depressed, the display of data starts when the trigger condition is satisfied. If the trigger is not depressed, the display of data starts immediately.

The trigger in the scope applies to the rightmost measurement on the left of the scope plot area.

I. Select Measurement for Trigger:
1. Click on the measurement name on the immediate left of the scope.

2. Select the measurement for the trigger from the drop-down list.

—Or—

1. Click **Allow rearrangement of axes** in the toolbar.

2. Click and drag the measurement to use as the trigger to the immediate left of the scope.
II. Turn on Trigger:

1. Click Trigger in the toolbar.

2. Click the pull down menu of the trigger.

3. Select:
   - Positive Edge
   - Negative Edge

A trigger indicator is displayed on the plot.
**Trigger Indicator**
- Indicators point up for **Positive Edge** and down for **Negative Edge** triggers.
- Trigger indicator color matches run color.

**How do I pre-trigger?**

🔗 See "What is pre-triggering in the scope?": 176

**Note:** An 850 Universal Interface is required to use the pre-trigger functionality.

1. Click **Trigger** in the toolbar.

2. Click the pull down menu of the trigger.

3. Select:
   - **Positive Edge**
   - **Negative Edge**

🔗 A trigger indicator is displayed on the plot.
How do I freeze and record the Scope display?

(See "How do I record data in PASCO Capstone?": 78 for information on Fast Monitor Mode.)

1. Select **Fast Monitor Mode** in the Controls Palette.
2. Adjust the sample rates of each of the measurements so that the sensors are sufficiently responsive for desired data.

3. Select one or more scope or FFT displays. (See "Adding a display": 61)

   **Note:** To record a single event, use the scope display and select Single Shot. (See "What does Single Shot do?": 175)

4. Click **Monitor** in the Controls Palette.
5. Click **Stop** in the **Controls Palette** to stop observing the data.

6. Scale the data to fit the display to record within the displays. (See "How do I pan and scale?" : 117)

7. **Click Snapshot** in the scope toolbar.

**Scope Toolbar: Snapshot**

Creates a data set from active traces

**Notes:**

Only the data that is visible in the plot area is recorded as a run when Snapshot is clicked.

Recorded data appear on the sensor tab in the **Data Summary** tab (.), and is selectable from any data display with a default name **Monitor Run--ScopeSnapshot%1** where %1 is an automatically generated run number and %2 is the ordinal (1, 2, 3...) (For example: **Run #1-ScopeSnapshot2** is the second snapshot of the first run).
How do I... Video

"How do I add a video source?": 144
"How do I analyze a video?": 145
"How do I manually synchronize video with data?": 147
How do I adjust the exposure controls for video recording?
"How do I adjust the frame rate of a recorded video?": 148
"How do I adjust the resolution of a video?": 148
"How do I make files with videos smaller?": 149
"How do I troubleshoot video problems?": 149

How do I add a video source?

PASCO Capstone supports most driverless (UVC 1.1) USB video sources, which includes almost all newer web cameras, USB microscopes, and telescopes, and many older USB video sources that require drivers.

Procedure

1. Connect a driverless (UVC 1.1) USB video source, such as a web camera, microscope, or telescope.

2. Drag and drop a Movie Display 🎬 from the Displays Palette to a workbook page. (See "Adding a display": 61)

3. Select one of the four choices presented in the display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Movie File</td>
<td>Use for Prerecorded QuickTime compatible videos.</td>
</tr>
<tr>
<td>Capture Image*</td>
<td>Use to capture a still image. (Do not use for video analysis.)</td>
</tr>
<tr>
<td>Record Explanatory Movie*</td>
<td>Use for videos that will not be synchronized to data. (The video records without data recording.)</td>
</tr>
<tr>
<td>Record Movie with Synced Data*</td>
<td>Use for a movie that you wish to keep synchronized to sensor data that will be recorded simultaneously. (The video records with data recording.)</td>
</tr>
</tbody>
</table>

*A live video is displayed in Movie Display.
How do I analyze a video?

You can manually track the path of objects in any recorded or compatible pre-recorded movie.

Tips for good results

- PASCO Capstone analyzes in two dimensions. Position the camera plane parallel to the plane of motion. (That is, point the camera perpendicular to the plane of motion.)
- Place the camera approximately at the center of the path of the object of interest.
- Use intense lighting (such as sunlight) to avoid motion blurring that might obscure the image.

Procedure

1. Add a camera. (See "How do I add a video source?": 144)
2. Add a Movie Display (See "Adding a display": 61)
3. Select a type of Movie Display:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Movie File</td>
<td>Use for Prerecorded QuickTime compatible videos.</td>
</tr>
<tr>
<td>Capture Image*</td>
<td>Use to capture a still image. (Do not use for video analysis.)</td>
</tr>
<tr>
<td>Record Explanatory Movie*</td>
<td>Use for videos that will not be synchronized to data. (The video records without data recording.)</td>
</tr>
<tr>
<td>Record Movie with Synced Data*</td>
<td>Use for a movie that you wish to keep synchronized to sensor data that will be recorded simultaneously. (The video records with data recording.)</td>
</tr>
</tbody>
</table>

*A live video is displayed in **Movie Display**.

* If using **Open Movie File**, skip to step 5.

4. Prepare recording.
a. Place a physical ruler (or object of known length) in the movie scene to determine scale.
b. Ensure the plane of action is parallel to the plane of the lens of the camera.

5. Record movie.
Using **Record Explanatory Movie**:

a. Start Recoding: ✂️click **Record** in the toolbar.  
   ➥The video records without data recording.

```
Toolbar: Video Record
```

b. Stop Recoding: ✂️click **Record** in the toolbar.

Using **Record Movie with Synced Data**:

a. Start Recording: ✂️click **Record** in the **Controls Palette**.
   ➥The video records with data recording.

```
Record
```

b. Stop Recording: ✂️click **Stop** in the **Controls Palette**.

6. ✂️Click **Enter video analysis mode** in the toolbar.

```
Toolbar: Video Analysis
```

7. Select the data run to use.
8. Optional: Change the units or length of the scale.
a. While in Video Analysis mode, click Properties.

b. Click Enter video analysis mode.

c. Modify as needed: Real World Length (Sets Real World Length In Specified Units).

d. Modify as needed: Data Units (Sets Length Units).

9. Adjust the scale tool to match the scale of the ruler (or object of known length) in the scene.

10. Click on the object that you would like to track.
   - Capstone places a + and the video will advance to the next frame.

11. Repeat until the object has been completely tracked.
   - The video analysis data appear on the Video Data Summary tab (ırken) in the Data Summary, and are selectable from any data display.

12. Open a Display (such as a Table, Graph, or Histogram). (See "Adding a display": 61)

13. Click <Select Measurement> in the display and select a video analysis measurement:
   - x-Position
   - y-Position
   - x-Velocity
   - y-Velocity
   - x-Acceleration
   - y-Acceleration

How do I manually synchronize video with data?

1. Add a Video Display. (See "How do I add a video source?": 144)
2. Open and existing video recording or record new video.
3. Add a table or graphic display with the data to use. (See "Adding a display": 61)
   - The page contains two displays: video of experiment and numerical data.
4. Click Playback Mode in the Controls Palette.
5. Click Play in the Controls Palette.
6. Playback the recorded data until an identifiable event occurs. (For example, the point of collision.)
7. Click **Manually synchronize movie with data** in the Video toolbar.

8. Click **View/adjust current movie playback position** in the Video toolbar.
   - A slider appears under ⌁.

9. Adjust the video slider until the video frame corresponds to the time of the identifiable event from step 6.

10. Click **Manually synchronize movie with data** in the Video toolbar.

### How do I adjust the frame rate of a recorded video?

Frequently high-speed or low-speed video files contain false frame rate metadata. Camera manufacturers deliberately do this so that the video plays back at a easily-viewable frame rate. For PASCO Capstone to synchronize the video correctly, the video rate in the file must be accurate.

**Procedure**

Change frame rate metadata of the video file, using a free video editor:

1. Download and install [Avidemux](https://avidemux.sourceforge.net/).
2. Right-click on your video file and select **Open with**....
3. Select **Avidemux**.
4. In Avidemux, select **Video**.
5. Select **Frame Rate**.
6. Check **Use Custom Frame Rate** and set the desired frame rate.
7. Save the file.
8. For adjusting the phase between the video and the data, see [Tech Note #493](https://www.pasco.com/docs/tech-notes).

### How do I adjust the resolution of a video?

The settings for all movies are 320×240×30 fps in order to keep file sizes low. A USB 2.0 camera is unlikely to drop frames at this rate. Higher resolutions or frame rates increases the probability of dropped frames.

If the camera supports higher resolutions, you may increase the resolution. (See "How do I adjust the frame rate of a recorded video?": 148)
How do I make files with videos smaller?

PASCO Capstone saves files as uncompressed. Select a compression codec to reduce the file size of recorded videos. The available codecs vary by computer, and some codecs may result in a movie that is not playable within PASCO Capstone.

Procedure

1. Add a movie to the workbook. (See "How do I add a video source?": 144)
2. Click Properties in the video toolbar.
3. Click Movie Recording.
4. Click Video Compression.
5. Select a video compression algorithm.

| Note: The compression algorithms available depend on the operating system and the software installed by the video camera. Different compression algorithms affect different properties of the video file including frame rate and frame size. |

6. Click OK.
7. Test: play the video in Capstone.
   - If the video no longer plays in Capstone, repeat steps and select a different algorithm.

How do I troubleshoot video problems?

Dropped Frames and Automatic Synchronization

The video sensor attempts to synchronize the movie with the data. This might not work if too many operating system processes are running simultaneously. (Windows and MAC are not a real time operating systems, and modern installations might have up to hundreds of processes running. The operating system can decide to let other process to have priority, resulting in dropped frames or synchronization issues.)

To improve performance of the auto-synchronization algorithm:

- Increase the sensor sample rate within PASCO Capstone
- Terminate unused processes in the operating system
- Temporarily disable virus scanners in operating system
- Turn off the internet connection in operating system
Capture Sound Issues

Some cameras are not automatically able to assign a matching microphone. If you are missing sound:

1. Click Properties 🗝️ in the video toolbar.
2. Click View/adjust current movie playback position.
   Choose a microphone. Some computers may not automatically choose the correct microphone. In these cases, you may select a camera and a microphone, and then choose "Save Defaults" to associate the camera and microphone.
   Click OK.
3. Test video recording and playback.
   If no audio, repeat steps to select a different Microphone source.

Windows Drivers

Open Device Manager: My Computer > Properties > Manage > Device Manager > Imaging Devices

If the camera does not appear in the Device Manager, try another USB port or disconnecting and reconnecting the camera to the same USB port.

If the camera appears in the Device Manager, ∈ click on it and press the delete button, unplug and replug the device into the USB port. Install the latest device driver provided by the manufacturer if requested.

- Devices that support the UVC (USB Video Class 1.1) standard do not need to have any special drivers installed to function in XP-SP3 or Windows Vista/7/8. Such devices appear automatically in Device Manager shortly after being connected.
- Older devices will need a driver installed.
- Older 16 Bit Devices (VFW devices) are not plug and play, and will appear to still exist after they have been physically disconnected. To uninstall such devices, ∈ right-click on the device in Device Manager and select “uninstall driver”

Testing in Windows

Windows Vista/Windows 7 Testing

Windows Vista/7 does not include a built-in video viewer. A simple utility that allows you to test a webcam in Windows Vista/7 can be found here:

http://www.bustatech.com/webcamviewer-a-simple-viewer-for-webcam/.

You can also use “Skype” or any other video-chat capable program to test a webcam.

Windows XP Testing
1. Close PASCO Capstone
2. Open Windows Explorer.
3. Look under **Scanners and Cameras**.
4. ![Icon] Click on the camera in use.
   - A window opens displaying the camera output.
5. Take a snapshot to test the camera.
6 FAQ

PASCO Capstone

"What is PASCO Capstone?": 154
"Where can I find help documentation and curriculum for PASCO Capstone?": 154
"What are the new features in the latest PASCO Capstone?": 155
"Can PASCO Capstone open DataStudio, SPARKlabs, and Xplorer GLX files?": 155
"Can Capstone files be opened on computers with different operating systems?": 156

Installation and Updates

"What licenses are required?": 157
"Is an MSI available for PASCO Capstone?": 157
"Do I need to update the interfaces?": 158
"Do I need to update the sensor datasheets?": 158

Setup

"What do I need to have a complete measurement system?": 159
"Can sensors sample at different rates?": 164

Data files

"Where is my data saved?": 162
"What is the file export format?": 162
"What is the format for text import?": 163

Data and Measurements

"Which data is recorded?": 164
"Can sensors sample at different rates?": 164
"What is Continuous Mode?": 165
"What is Fast Monitor Mode?": 166
"Is there a way to delete data points?": 167
"Which data is active?": 169
"How are the curve fit and smoothing calculations determined?": 169

Calculations and Calibration
"What is the format for calculations?": 171
"What are the equations for calibration?": 171
"Can multiple measurements be calibrated simultaneously?": 172

Displays

"What is panning and scaling?": 173
"Why are the display toolbars not active?": 174

Scope

"What is the scope?": 175
"What does Single Shot do?": 175
"FAQ... Scope": 175

Video and Text

"What cameras and video formats are supported?": 177
"Why does the text color remain black after picking a color?": 177
FAQ... PASCO Capstone

"What is PASCO Capstone?": 154
"Where can I find help documentation and curriculum for PASCO Capstone?": 154
"What are the new features in the latest PASCO Capstone?": 155
"Can PASCO Capstone open DataStudio, SPARKlabs, and Xplorer GLX files?": 155
"Can Capstone files be opened on computers with different operating systems?": 156

What is PASCO Capstone?

PASCO Capstone is a feature-rich data acquisition, visualization, and analysis program designed by PASCO scientific for advanced science education. In addition, Capstone contains the tools needed for the creation and execution of structured scientific inquiries, by allowing simple drag-and-drop integration of rich text, graphics, video, and data displays on multiple page displays called workbooks.

Capstone is completely compatible with all PASCO USB Interfaces, including the 850 Universal Interface, Xplorer GLX, SPARKlink, SPARKlink Air, SPARK SLS, USB Link and older interfaces such as the ScienceWorkshop 750 or 500.

🔗 See "Tour the Interface": 4

Where can I find help documentation and curriculum for PASCO Capstone?

Where can I find Capstone documentation?

PASCO Capstone is designed to be as intuitive as possible. In addition the following Help is available:

- **Tool Tips**: hover over a button to view the associated tool tip.

  ![Tool tips: hover over to display tool tips](image)

  Drag to page or double-click to create a display

- **Context Help**: helpful information at the bottom of dialog windows. (🔗 See "Tour Context Help": 18)
Online Help: searchable instructions on working with PASCO Capstone, frequently asked questions, and links to instructional videos.

- Click Help > PASCO Capstone Help (or F1)
- Teacher Support: for specific questions that are not answered by these resources. (See "Teacher and Technical Support": 3)

What curriculum is available for Capstone?

A number of Capstone experiments designed for the 850 Universal Interface can be downloaded. (See "Downloading Capstone experiments": 66)
In addition, Capstone can open and convert many DataStudio 1.9.x and GLX (*.glx) files. (See "How do I open DataStudio experiments and data?": 73)

What videos are available for Capstone?

See the following online video sources for specific How Do I videos and general PASCO related topics.

"Online Videos": 2

What are the new features in the latest PASCO Capstone?

See the following website for a complete change history for PASCO Capstone:

PASCO Capstone Release History

Can PASCO Capstone open DataStudio, SPARKlabs, and Xplorer GLX files?

Can PASCO Capstone open DataStudio files?

Yes.
PASCO Capstone can open and convert most DataStudio 1.9 files to Capstone format.

See "How do I open DataStudio experiments and data?": 73

Can PASCO Capstone open SPARKlabs?

No.
PASCO Capstone cannot open SPARKlabs.
Can PASCO Capstone open saved GLX (*.glx) files?

Yes.
PASCO Capstone can open and convert most Xplorer GLX files to PASCO Capstone format.

🔗 See "How do I open DataStudio experiments and data?": 73

Can PASCO Capstone transfer files from the Xplorer GLX?

Yes.
PASCO Capstone can transfer most Xplorer GLX files for use in Capstone.

🔗 See "How do I import Xplorer GLX data?": 76

Can Capstone files be opened on computers with different operating systems?

Yes.
PASCO Capstone files (.cap) that are created on either a Mac or PC can be opened on another computer running another operating system compatible with Capstone (Mac OS, Windows) with the same version or later of Capstone.
FAQ... Installation and Updates

"What licenses are required?": 157
"Is an MSI available for PASCO Capstone?": 157
"Do I need to update the interfaces?": 158
"Do I need to update the sensor datasheets?": 158

What licenses are required?

What licenses are available for PASCO Capstone?

- Capstone Single User License (UI-5401)
- Capstone Site License (UI-5400)

Does the license expire?

No.

The license does not expire and entitles you to minor updates, such as the update from version 1.0 to 1.1.

Are upgrades free?

Yes, minor upgrades are free.

Minor upgrades and bug fixes for the licensed version of PASCO Capstone do not require additional purchase. They may be obtained by downloading the latest trial version from the PASCO scientific website. If the previous version of Capstone was licensed, the minor upgrade will accept the license key stored in your computer.

If you do not have a valid license key, the trial will expire in 60 days. A new license key may be purchased and entered from the About PASCO Capstone menu:

1. Click Help > About PASCO Capstone
2. Click Buy Key or Enter Key

Is an MSI available for PASCO Capstone?

An independent msi is not available for PASCO Capstone. The Capstone msi is wrapped by InstallShield®; parameters may be passed to the msi with command line switches. (See "How do I automate a network installation?": 71) for information on passing parameters to the msi.
Do I need to update the interfaces?

PASCO Capstone will prompt to update the firmware if a new version exists. Follow the on-screen instructions.

However, you may encounter a problem with the interface requiring a manual firmware re-installation. (See "How do I force an update to an interface?": 71)

Do I need to update the sensor datasheets?

No.

PASCO Capstone obtains default sensor information from a file that is installed and updated with Capstone.

(DataStudio and SPARKvue do obtain information from the sensors; however, Capstone ignores any information from the sensor other than the ID.)
FAQ... Setup

"What do I need to have a complete measurement system?": 159
"Can sensors sample at different rates?": 164

What do I need to have a complete measurement system?

Required Components

A complete measurement system consists of the following components:

The equipment required depends on the type of sensor used.

PASPORT Sensor Connections

PASPORT sensors have part numbers that are prefixed with PS-. These sensors feature auto identification, digital communication, and the ability to measure multiple quantities simultaneously (on some sensors).

Sensors connect as follows:
ScienceWorkshop Sensor Connections

ScienceWorkshop sensors have part numbers that are prefixed with CI-. There are two classes of ScienceWorkshop sensors: analog and digital. The analog sensors may be identified by their round 8-pin DIN connectors. The digital sensors are identified by their 3.5 mm Tip-Ring-Sleeve (headphone) connectors.

These sensors connect as follows:
Can sensors sample at different rates?

Yes.

PASPORT sensors may have sampling rates different from the sampling rates of other PASPORT or ScienceWorkshop sensors.

Note: All ScienceWorkshop sensors sample at the same rate. PASPORT sensors can sample at different rates.
FAQ... Data files

"Where is my data saved?": 162
"What is the file export format?": 162
"What is the format for text import?": 163

Where is my data saved?

Recorded data is contained within the PASCO Capstone file (identified by the .cap extension).

Note: Data is not permanently saved unless the PASCO Capstone file is saved or the data exported. If Capstone closes, without saving or exporting the data, all data will be lost.

What is the file export format?

PASCO Capstone exports data in tab or comma delimited files with the following information:

- Run [ID]/Set [ID]
- [Measurement] ([Unit])
- Value
- Value

Note: The precision of the exported data matches the numerical properties of the measurement. (See "How do I change the numerical format of data?": 86)

Example

<table>
<thead>
<tr>
<th>Run #1</th>
<th>Run #1</th>
<th>Run #1</th>
<th>Run #2</th>
<th>Run #2</th>
<th>Run #2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (s)</td>
<td>Force (N)</td>
<td>Position (m)</td>
<td>Time (s)</td>
<td>Force (N)</td>
<td>Position (m)</td>
</tr>
<tr>
<td>0.000</td>
<td>0.61</td>
<td>0.16</td>
<td>0.000</td>
<td>0.63</td>
<td>0.17</td>
</tr>
<tr>
<td>0.050</td>
<td>0.42</td>
<td>0.26</td>
<td>0.050</td>
<td>0.44</td>
<td>0.26</td>
</tr>
</tbody>
</table>
What is the format for text import?

Imported data are listed in the User-Entered Data Summary tab (📝) of Data Summary.

The recommended format for file import is tab-delimited text with the measurement names and units on the first line:

\[
\begin{align*}
MN_1 (u_1) & \rightarrow MN_2 (u_2) \cdots \rightarrow MN (u_n) \ [CR] \\
M_1 V_1 & \rightarrow M_2 V_1 \rightarrow \cdots \rightarrow M_n V_1 \ [CR] \\
M_1 V_2 & \rightarrow M_2 V_2 \rightarrow \cdots \rightarrow M_n V_2 \ [CR] \\
\vdots & \\
M_1 V_m & \rightarrow M_2 V_m \rightarrow \cdots \rightarrow M_n V_m \ [CR]
\end{align*}
\]

**Where:**

- \(MN_n\) ≡ measurement name of the \(n^{th}\) measurement
- \(u_n\) ≡ unit of measure of the \(n^{th}\) measurement–leave off if no units
- \(M_n V_m\) ≡ \(m^{th}\) value of the \(n^{th}\) measurement
- \(\rightarrow\) ≡ tab
- \([CR]\) ≡ carriage return

**Note:** PASCO Capstone may not recognize data that does not exactly fit the recommended file import format.

**Example text file:**

<table>
<thead>
<tr>
<th>animal</th>
<th>family</th>
<th>speed (km/h)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peregrine Falcon</td>
<td>Falco peregrines</td>
<td>389</td>
</tr>
<tr>
<td>Golden Eagle</td>
<td>Aquila chrysaetos</td>
<td>320</td>
</tr>
<tr>
<td>Gryfalcon</td>
<td>Falco rusicolus</td>
<td>208</td>
</tr>
</tbody>
</table>

See "How do I import data from Microsoft Excel*? ": 74
FAQ... Data and Measurements

"Which data is recorded?": 164
"Can sensors sample at different rates?": 164
"What is Continuous Mode?": 165
"What is Fast Monitor Mode?": 166
"Is there a way to delete data points?": 167
"Which data is active?": 169
"How are the curve fit and smoothing calculations determined?": 169

Which data is recorded?

PASCO Capstone records data for each available measurement (All data is recorded for immediate or future use in displays, calculations, and analysis.) and associated time data at the defined sample rate(s).

Data appear on the specific sensor tab in the Data Summary tab ( ), and is selectable from any data display with a default name Run #%1, where %1 is an automatically generated run number.

See "How do I record data in PASCO Capstone?": 78

Can sensors sample at different rates?

Yes.

PASPORT sensors may have sampling rates different from the sampling rates of other PASPORT or ScienceWorkshop sensors.

Note: All ScienceWorkshop sensors sample at the same rate. PASPORT sensors can sample at different rates.
What is Continuous Mode?

In this mode (See "How do I record data in PASCO Capstone? " : 78):

- Data continuously records as soon as Record 🄰 is activated in the Controls Palette.

- Data displays at the specified sampling rate(s) either until the hardware is no longer able to process the data (at which time data collection will stop with an error message) or until the Stop 🅰️ is pressed.

**Maximum Frame Rate**

The maximum frame rate\(^1\) is directly related to the processing speed of the host and inversely related to the number of samples per frame: \(S_F\).

Where:

\[
S_F = R_s \times T
\]

\(S_F\) ≡ Samples per frame

\(R_s\) ≡ Sampling rate (displayed in the Controls Palette)

\(T\) = time specified on the right of the plot area window

**Automatic Sample Rate (\(R_s\))**

Select auto-sample-rate-adjustment 🔄 to enable automatic sampling rate:

- The sampling rate will increase when zooming into the time axis or when increasing the number of samples per frame by using increase-samples-per-trace 📈.

- The sampling rate will decrease when zooming out of the time axis or when decreasing the number of samples per frame by clicking decrease-samples-per-trace 📈.

**Manual Sample Rate (\(R_s\))**

Deselect auto-sample-rate-adjustment 🔄 to disable automatic sampling rate:

\(^1\)The rate at which these frames of data are displayed.
The sampling rate is set in the Controls Palette.

What is Fast Monitor Mode?

In this mode (See "How do I record data in PASCO Capstone?: 78):

- The scope display behaves like a digital storage oscilloscope.
- Data is manually recorded using Snapshot. (See "How do I record data in PASCO Capstone?: 78)

Notes:
Only the data that is visible in the plot area is recorded as a run when Snapshot is clicked.
Recorded data appear on the sensor tab in the Data Summary tab ( ), and is selectable from any data display with a default name Monitor Run--ScopeSnapshot%1 where %1 is an automatically generated run number and %2 is the ordinal (1, 2, 3...) (For example: Run #1-ScopeSnapshot2 is the second snapshot of the first run).

- The scope will not drop samples within a frame due to an excessive sample rate.
- The trigger, by definition, occurs at a scope time of 0.00.
- The scope displays complete frames of data. (The maximum frame rate\(^1\), depends on the processing speed of the host computer.)

Maximum Frame Rate

The maximum frame rate\(^2\) is directly related to the processing speed of the host and inversely related to the number of samples per frame: \(S_F\).

Where:
\[
S_F = R_S \times T \\
S_F \equiv \text{Samples per frame} \\
R_S \equiv \text{Sampling rate (displayed in the Controls Palette)} \\
T = \text{time specified on the right of the plot area window}
\]

\(^1\)The rate at which these frames of data are displayed. 
\(^2\)The rate at which these frames of data are displayed.
Automatic Sample Rate ($R_s$)

Select auto-sample-rate-adjustment to enable automatic sampling rate:

- The sampling rate will increase when zooming into the time axis or when increasing the number of samples per frame by using increase-samples-per-trace.
- The sampling rate will decrease when zooming out of the time axis or when decreasing the number of samples per frame by clicking decrease-samples-per-trace.

Manual Sample Rate ($R_s$)

Deselect auto-sample-rate-adjustment to disable automatic sampling rate:

- The sampling rate is set in the Controls Palette.

Is there a way to delete data points?

Yes.

In PASCO Capstone version 1.1 or later, data points can be deleted or excluded.

- Neither excluded nor deleted points are included in curve fits or statistical calculations.
- If data points are excluded, they remain in the displays and are marked:
• with an X in the plot

![Deleted and Excluded Data in a Plot](chart)

Deleted data are removed. Excluded data display with "X" marks.

• with a strike-through in the table

![Deleted and Excluded Data in a Table](table)

Deleted data are removed. Note the gap in time data. Excluded data display with strikethrough.

• If data points are deleted, they disappear from all of the displays. Either of these functions may be reversed with Undo.

🔗 See "How do I exclude, delete, and restore selected data?": 89
**Which data is active?**

By default, the last selected measurement of the last data run is the active data for statistics and other actions.

🔗 See "How do I select active data?": 118

**How are the curve fit and smoothing calculations determined?**

**How are the errors in the parameters of the linear curve fits calculated?**

The linear model error estimations were derived assuming that there is no error in the reported measurements and tends to underestimate the actual error in the parameters. The errors are calculated as follows:

**Where:**

- \( m \equiv \) slope
- \( b \equiv \) intercept
- \( N \equiv \) number of values \((x_i, y_i)\)
  
- and...

**What is the algorithm used by the graph smoothing tool?**

The graph smoothing tool uses a center-weighted [Savitzky–Golay smoothing](https://en.wikipedia.org/wiki/Savitzky%E2%80%93Golay_smoothing) algorithm of degree 4. The the value displayed in the Data Smoothing Slider \( n \) is an odd value representing the total number of values in the original data set that are used in determining each smoothed value.
Coefficient weights are used, such that the values closest to the value being smoothed usually have a greater weight, and thus a greater influence on the determining the resulting smoothed value. These coefficients are symmetric unless there are fewer than unsmoothed values to both sides of the smoothed value.
FAQ... Calculations and Calibration

"What is the format for calculations?": 171
"What are the equations for calibration?": 171
"Can multiple measurements be calibrated simultaneously?": 172

What is the format for calculations?

Calculations have the format:

(variable name) = (valid functional expression)

The variable name may contain symbols, common subscripts and superscripts, and spaces.

If you enter a functional expression without (variable name) = , Capstone adds a generic name and "=". For example: Calc1= for variables and Constant1= for constants.

Calculations that involve only constants are immediately evaluated in the user-entry area. Calculations involving measurements are rendered in MathML. (See "How do I see the result of a calculation?": 110)

Examples

Constant1=2*3

Calc1=[\text{Acceleration}(\text{m/s}^2)]^2

Γ^2=\sin([\text{Angle}(\text{rad})])

Φ=\text{integral}([\text{Force}(\text{N})],[\text{Time}(\text{s})])

Resultant Acceleration=sqrt([\text{Acceleration}_x(\text{m/s}^2)]^2+[\text{Acceleration}_y(\text{m/s}^2)]^2+[\text{Acceleration}_z(\text{m/s}^2)]^2)

What are the equations for calibration?

The actual value, y(x) is calculated using measured value x and the calibration points \((x_i, y_i)\), where \(x_i\) is the \(i\)th measured value and \(y_i\) is the corresponding actual (standard) value:
1 Point Offset

Examples: used internally by the force sensors, accelerometers

1 Point Slope

Examples: dissolved oxygen, type-K temperature, conductivity, drop counter

2 Point Linear

Examples: pH and other ion selective electrodes

Can multiple measurements be calibrated simultaneously?

Yes.

You may calibrate multiple measurements simultaneously if they are of the same type and exposed simultaneously to the same standards when performing the calibration.

Note: Simultaneous calibration is not recommended for pH, ISE, ORP, Conductivity, stainless-steel temperature sensors without insulating sleeves, or Dissolved Oxygen sensors because these sensors will not read correctly if the probes are placed in the same solution simultaneously.

🔗 See "How do I calibrate a sensor?": 100
FAQ... Displays

"What is panning and scaling?": 173
"Why are the display toolbars not active?": 174

What is panning and scaling?

PASCO Capstone supports several panning and scaling methods:

- User (manual) **Scaling**\(^1\) and **Panning**\(^2\)
- Scaling based on maintaining the visibility or new data
- Scaling and panning the data to maximize the visibility of existing data

🔗 See "How do I pan and scale?": 117.

**What is Panning** *Moving the origin within the display. Scale does not change.*

Panning is the process of changing the value of the constant P in the Scaling and Panning Equation.

**What is Scaling** *Changing the axis scale (value between tick marks) to zoom-in or zoom-out. Origin does not change.*

Scaling is the process of changing the value of S in the Scaling and Panning Equation.

\(^1\)Changing the axis scale (value between tick marks) to zoom-in or zoom-out. Origin does not change.  
\(^2\)Moving the origin within the display. Scale does not change.
The process of increasing the value of the scaling factor $S$, is said to be zooming in and decreasing the value of the scaling factor is said to be zooming out.

**What is Zooming-in/out around a point** Changing the scale and origin around a single point.

You can simultaneously scale and pan such that a point other than the origin (for example: $(m_{10}, m_{2})$) remains stationary in the plot area when scaling. This process is the equivalent of scaling by $S$ and panning by $m_{10} \times S$ for each coordinate.

**Scaling and Panning Equation**

\[
\begin{align*}
    x_i & \equiv \text{virtual value of the } i^{\text{th}} \text{ coordinate within the plot area} \\
    m_i & \equiv \text{the } i^{\text{th}} \text{ measurement value} \\
    m_{10} & \equiv \text{the coordinate value of the scaling stationary point} \\
    S & \equiv \text{scaling factor} \\
    P & \equiv \text{panning factor}
\end{align*}
\]

**Why are the display toolbars not active?**

Toolbars are only active when a single display is active, and will only apply to the active display.

For displays with multiple plots such as for Graph or FFT displays, the toolbar actions apply to the active plot within the display.

🔗 See "How do I select active data?": 118
FAQ... Scope

"What is the scope?": 175
"What does Single Shot do?": 175
"FAQ... Scope": 175

What is the scope?

The scope is designed to view high-frequency oscillating data or single high-speed events that the graph display may not be able to capture.

**Maximum Sampling Rate:** The maximum supported sampling rate is a function of the computer-sensor interface that is connected to the computer (for example: 850 Universal Interface → 10 MHz, ScienceWorkshop 750 → 250 kHz).

<table>
<thead>
<tr>
<th>Features</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous Mode</td>
<td>&quot;What is Continuous Mode?&quot;: 165</td>
</tr>
<tr>
<td>Fast Monitor Mode</td>
<td>&quot;What is Fast Monitor Mode?&quot;: 166</td>
</tr>
<tr>
<td>Single shot</td>
<td>&quot;What does Single Shot do?&quot;: 175</td>
</tr>
<tr>
<td>Multiple triggers</td>
<td>&quot;How do I select the scope trigger?&quot;: 138</td>
</tr>
<tr>
<td>Pre-trigger</td>
<td>&quot;How do I pre-trigger?&quot;: 141</td>
</tr>
<tr>
<td>Image freeze</td>
<td>&quot;How do I freeze and record the Scope display?&quot;: 142</td>
</tr>
</tbody>
</table>

What does Single Shot do?

Single Shot is useful for fast, non-repetitive events, such as measuring the time between an impulsive sound and its echo to determine the speed of sound.

When Single Shot is depressed on the scope toolbar and Monitor is pressed on the Controls Palette, the scope displays one frame of scope data and then stops monitoring.
Monitor

Start monitoring measurements from connected sensors

**Note:** If the trigger in the scope toolbar is depressed, the display of data starts when the trigger condition is satisfied. If the trigger is not depressed, the display of data starts immediately.

**Note:** Fast Monitor Mode is required for the Single Shot function.

**Note:** Single Shot is limited by the hardware buffer size of the interface (~ 2000 samples for the 750 interface and ~ 16000 sample for the 850 Universal Interface).

**What is pre-triggering in the scope?**

The 0.00 second measurement on the scope is referenced to the time of the scope triggering event. Recording and displaying data that happened before a triggering event is called pre-triggering.

**Note:** An 850 Universal Interface is required to use the pre-trigger functionality.

🔗 See "How do I pre-trigger?": 141
FAQ... Video and Text

"What cameras and video formats are supported?": 177
"Why does the text color remain black after picking a color?": 177

What cameras and video formats are supported?

Supported cameras

- PASCO Capstone supports the UVC (USB Video Class 1.1) standard. Cameras that support UVC do not require additional drivers.
- UVC 1.1 cameras are recommended; however, some older cameras may work with Capstone with the drivers developed by the manufacturer.

🔗 See "How do I troubleshoot video problems?": 149

Supported video formats

- PASCO Capstone will record and playback video recorded in Capstone without any supporting software.
- Capstone requires the latest version of the Apple QuickTime* player to playback movies that were not recorded in Capstone. Once QuickTime is installed, Capstone can playback all movies with the mov file extensions and most movies with the mp4 or avi extensions.

Why does the text color remain black after picking a color?

PASCO Capstone uses the Hue-Saturation-Value (HSV) model to determine the color. The default value of the color value (brightness) defaults to 0 and the color displays black.

To display the selected color: move the brightness slider for the desired brightness.
Legal Notices

Document Number: 012-14016C

Limited Warranty

For a description of the product warranty, see the PASCO scientific catalog.

Copyright

This User's Guide is copyrighted with all rights reserved. Permission is granted to non-profit educational institutions for reproduction of any part of this manual, providing the reproductions are used only in their laboratories and classrooms, and are not sold for profit. Reproduction under any other circumstances, without the written consent of PASCO scientific, is prohibited.

Trademarks

PASCO, PASCO scientific, PASCO Capstone, DataStudio, PASPORT, SPARK, SPARK Science Learning System, SPARKlab, SPARKbook, SPARKvue, SPARKvue HD, Xplorer, Xplorer GLX are trademarks or registered trademarks of PASCO scientific, in the United States and/or in other countries. All other brands, products, or service names are or may be trademarks or service marks of, and are used to identify products or services of their respective owners. For more information visit: www.pasco.com/legal.

Software Licenses

All required licenses for software components of Capstone can be found on the Flash Drive, CD-ROM, or DVD-ROM included with the product or are included in the software download. To obtain source code for GPL/LGPL licensed software components, contact PASCO scientific by phone: 1-800-772-8700 (in the U.S), +1 916 786 3800 (worldwide), or by email: support@pasco.com

(2015-05-01 v1.4-a)